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TEACHER’S RESOURCE

About the Series

The computer in present-day society is an indispensable tool facilitating communication and work. From huge
machines weighing several tons, the computer has evolved into light, sleek yet powerful tools that dominate
today’s knowledge society. Many previously complex and time-consuming tasks have been reduced to the
mere touch of a few buttons on the keyboard. Basic computing skills like word processing are an essential
requirement in today’s job market. The Internet has revolutionised the way people communicate and interact.
Geographical distances are no longer a constraint for effective business transactions, information dissemination,
and interpersonal interactions, as distances have been overcome through extensive, intricately-designed
communication networks.

Today computer science is an academic subject in its own right, governed by scientific and mathematical principles.
It is an integral part of what is commonly called STEM (Science, Technology, Engineering, and Mathematics).
Due to its increasing importance, computer classes have become an essential part of the education curriculum
around the world.

However, the trend has been to favour Information and Communication Technology (ICT) rather than the science
behind computers. ICT in schools usually focuses only on teaching how to use office productivity software, such
as, word processors, presentation software, and spreadsheets. We, as teachers, should be careful that we teach
not only ICT, but also computing, especially in the lower classes. This is an important distinction because ICT
primarily involves simply understanding and memorising commands. As a consequence many students may
get the impression that there is not much of creativity involved in using computers. This may possibly result in
students losing interest in what they mistakenly believe to be computing. Students are not introduced to how
computers work and are not provided with the opportunity to be creative through computing activities that
challenge them to use their logical and analytical abilities along with being creative.

Computer science education should be such that children later on, if they choose to do so, would be capable of
making a meaningful contribution either to further advance our digital society or use digital media optimally
in their chosen field of study or work. Computer education in schools should equip every child with the basic
understanding of how computers work and with the possibilities of information technology in a knowledge-
based society and economy. This has been the rationale for developing this third edition of the Keyboard
series—Keyboard: Computer Science with Application Software.
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KEYBOARD: COMPUTER SCIENCE WITH APPLICATION SOFTWARE

Keyboard: Computer Science with application Software, third edition, a series of eight books for Classes 1 to
8, is a comprehensively revised edition of Keyboard: Computer Science with application Software, second
edition, and carries forward the very same interesting and interactive approach that is a hallmark of the existing
edition. The series aims to make the study of computer science engaging and interactive for students through
a combination of interesting features.

The contents are based on the most recent feedback from teachers and incorporate the latest trends in computer
education. We have taken particular care to update facts and figures, and to include the latest advancements
in the field of information and communication technology. Thus, trendsetting topics such as social networking
and cloud computing have been explained along with devices such as smartphones and tablets. Also, in keeping
with the times, there is greater focus on animation and web-designing concepts.

The series introduces the subject in a language that is simple and direct. Technical jargon is used only where
necessary and all such terms are defined at the end of each chapter. Comic strips, icons, cartoon characters, and
illustrations make the learning process an enjoyable experience.

Keyboard: Computer Science with Application Software is an advanced course in computer science meant
for those schools that wish to teach creative application software, such as Flash, HTML, Photoshop, and
Dreamweaver, along with the basic concepts of computers, computer programming, and the Internet. In keeping
with the times it also introduces students to sound (Audacity) and video-editing (Lightworks) software.

COURSE FEATURES AND HIGHLIGHTS

Each chapter in Keyboard: Computer Science with Application Software starts with an engaging introduction
in comic strip format presenting a conversation between two characters, Goggle and Toggle. Goggle represents
an average primary and middle school student, while Toggle is an animated laptop and an expert in computer
science. Toggle helps Goggle understand all that is taught about computers and computer software in the series.
The series has a hands-on approach to learning with text supported by relevant screenshots, and plenty of
practical exercises. The MS Office screenshots are based on MS Office 2013, with the compact and user-friendly
Windows 7 as the operating system.

Practice Time, Exercises, In the Lab, and Group Project

Practice Time is a feature that has been a part of all the computer science series we have written, and it has
been found by teachers to be a very useful feature. We continue with it in Keyboard: Computer Science with
Application Software also. The feature provides practical exercises after every major topic, in which the student
applies the concept(s) learnt in the previous section to solve a practical problem. The detailed solution is given
after the question, so that students are able to understand the practical application of a particular concept on
their own. This frees the teacher from the process of trying to individually assess whether all the students have
properly grasped the concept.

The Exercises and In the Lab questions in the series deserve particular mention. as they have been developed
according to Bloom’s Taxonomy. The exercises in each chapter have sufficient theoretical and practical questions
for concept application.

Application-Based Questions is a special analytical section within Exercises, aimed at encouraging students to
evaluate a picture or a situation, and answer questions based on them.

The In the Lab questions are similar to those under Practice Time except that the solutions are not given. The
questions too are more complex than those found under Practice Time. In both, however, the questions describe
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a variety of situations across subjects. Thus, both attempt to integrate the use of computers with problem-solving
in other subjects.

Group Projects encourage the students to work in collaboration with their peers and implement what they
learnt in the lessons.

Worksheets and Assessment Papers

Worksheets have been introduced in Classes I to V, while for Classes VI to VIII Assessment and Comprehensive
Assessment papers have been included.

Teaching Resources

The teacher’s resources for the Keyboard: Computer Science with Application Software, series have two components:
(a) Teaching Guides and (b) Teacher’s Digital Resources.

Teaching Guides

The Teaching Guides accompanying each of the coursebooks is carefully structured to provide useful support
to teachers.

Each Teaching guide contains the following:

¢ A Lesson Plan that details the periods recommended for a particular chapter, the topics therein, the expected
learning outcomes at the end of each topic, and the digital support available for each chapter. This is intended
to assist teachers in respect of overall planning. Teachers may go through the lesson plan before stepping into
the class or may use the recommendations for creating their own.

* A set of chapter-wise Worksheets follows the lesson plans, and has questions in the form of Crossword
Puzzles, Word Searches, Jumbled Words, etc. designed to reinforce conceptual understanding.

* In addition to the Worksheets, a set of chapter-wise test papers has also been provided, which may be used
by teachers to create their own assessment papers, or may be used as they are for classroom tests.

¢ The complete Answer Key to the Coursebook Exercises has been given in the teaching guide, including that
for the In the Lab questions, Group Project, Worksheets/ Assessment papers, Revision Questions, and the
Cyber Olympiad Questions.

Digital Resources
The teacher’s digital support for the series is accompained by a Test Generator.

This comprehensive and easy-to-use Test Generator is an effective assessment tool designed to benefit teachers
by enabling them to create a variety of test papers.

It has two sections: (a) Coursebook questions (b) Questions beyond the coursebook.

Both include an extensive pool of questions, such as multiple choice, true or false, fill in the blanks, short
answer, and long answer questions, as well as lab exercises wherever relevant. Answers have been provided
to enable efficient and effective evaluation. The Test Generator allows the teacher to create test papers for one
or more chapters, with a mix of questions from both the sections. The Student’s Books, and the accompanying
Teaching Guides and teacher’s digital support, together form a complete package enabling one to teach the
subject effectively.
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Continuous and Comprehensive Evaluation

Learning takes place in a variety of ways — through experience, making and doing things, experi-mentation,
reading, discussion, asking, listening, thinking and reflecting, and expressing oneself in speech, movement or
writing. All these modes of learning are possible both individually and in groups. It would thus be advantageous
for children to be given the opportunity to involve themselves in as many of these activities as possible.

CONTINUOUS AND COMPREHENSIVE EVALUATION (CCE)

The primary objectives of this system are (1) to maintain continuity in evaluation and (2) to reliably assess broad-
based learning and behavioural outcomes.

In this system the term ‘continuous’ is meant to emphasize that evaluation of a student’s progress is a continuous
process rather than an event. It is spread over the entire span of an academic session, and means regularity
of assessment and unit-testing. It also includes a diagnosis of learning gaps, the use of corrective measures,
retesting, as well as self-evaluation.

The term ‘comprehensive’ suggests that the system should cover both scholastic and co-scholastic aspects of a
student’s growth and development.

This system expects assessment to be both formative and summative. Formative assessment is a tool used by the
teacher to continuously monitor student progress in a supportive environment. It involves regular descriptive
feedback, a chance for the student to reflect on the performance, take advice and improve upon it. If used
effectively it can improve student performance tremendously.

Summative assessment is carried out at the end of a course of learning. It measures or ‘sums-up” how much a
student has learned from the course. It is usually a graded test, i.e., it is marked according to a scale or set of grades.

It has been found that assessment that is predominantly of a summative nature will not by itself be able to yield
a valid measure of the growth and development of the child. It, at best, certifies the level of achievement only
at a given point of time.

The paper-pencil tests are basically a one-time mode of assessment and to exclusively rely on it to decide about
the development of a child is both unfair and unscientific. Over-emphasis on examination marks makes children
assume that assessment is different from learning. Besides encouraging unhealthy competition, the reliance on
a summative assessment system also results in great stress and anxiety among learners.

The Keyboard: Computer Science with Application Software, series, comprising of Student’s Books, Teaching
Guides, and Digital Resources, has a number of features that aid both continuous and comprehensive evaluation.

CONTINUOUS EVALUATION

Coursebooks
Beginning of Instruction (Formative Assessment)

¢ The introductory dialogue at the beginning of each chapter between Goggle and Toggle is a starter to the
chapter topic and can be employed to test the prior knowledge of students by using the dialogue to ask for
possible solutions or an answer to Goggle’s question. For example, in the following dialogue you can also
ask them what is the alternative to clicking the Run button.
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Umm... let me see...
did you click the Run
button after typing your

command?

Hi, Toggle! I've
been waiting  }
for you.

y

At your service,
Sir. How can |
help you?

Now, that’s the

This turtle is giving reason the turtle
me trouble. It doesnt obey is not obeying

my commands! you.

During Instruction (Formative Assessment)

* The conceptual grasp of students can be assessed during instruction through Practice Time, which has been
placed after every major topic in the Student’s Book, by observing how fast they carry out the task as given. A
couple of questions may also be added to test their understanding of the concept. For example, in the question
below students may be asked if they can use the tl command in the solution to this question instead of the tr

command.
ol
PRACTICE TIME ()
Tina wants to draw a rectangle of breadth 40 steps and length 60 steps ] reset
in KTurtle using the turnright (tr) command. Can you help 2 fw 40
her out? 3 tr 90
4 fw &0
5 tr 90
SOLUTION 6 fu 40
1. Tina should type the code given alongside in the KTurtle Editor 7 tr 90
pane. 8 fw &0
g tr 90|

2. After typing the code, she should click the Run
button.
3. The output will appear as given here.

Note: Try doing the same using the t1 command also.
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End-of-Chapter (Summative Assessment)

* Attheend of the chapter the student can be tested on acquired knowledge through the objective and descriptive
questions of the Exercises, the Application-Based Questions, and on the practical application of concepts
through In the Lab questions, and Group Project.

_ﬂ[ﬂ!ﬂﬂ\_ Application-Based Questions

Objective Type Questions a. Observe the given figure on the right and

1. Fill in the blanks with the correct words. answer the following questions: - = —
P drawing open cm undo i. Which tool is selected in the figure? ] .o §o— ‘l
a. The...... ... canvas is present at the center of the main screen. ii. Name the modifier that has been used to — -
b. The ... s 100l s used to load the already saved pictures. draw line A. e

Name the modifier that has been used to

c. The Help area is present at the ........................ of the Tux Paint screen. iii.

d. The...... .... tool is used to type text and numbers in drawing area. draw line B. . _

e The... command will cancel the last drawing action. iv. Which modifier will you use to draw B avd
2. WriteT for the true statement and F for the false one.
a. The Eraser tool can have different sizes.
b. The Line tool can be used to draw curved lines
c. The Help Area provides information about the selected tool while drawing
on the canvas, INTHE LAB
d. There are 18 colors in the Tux Paint palette. The first 17 are fixed while the 1. Amir has designed a NewVear greeting card in Paint as shown below. Make a New Year

18" color can be changed. ) 2 } ; A Bt
greeting card of your own, using the various tools in Paint, for your teacher.
e. The Tools are present on the right side of the Tux Paint main screen.

End-of-Unit and Term (Formative as well as Summative Assessment)

* Assessment at the end of a unit, or a set of three or four chapters, is facilitated through Worksheets in classes
ItoV.

TEACHING GUIDES
The Teaching guides provide the following support for formative and summative assessment:

* Worksheets, one for each chapter, have questions in the form of Crossword Puzzles, Word Searches, Jumbled
Words, etc. designed to reinforce conceptual understanding.

* Test papers, one for each chapter, which may be used by teachers by photocopying them in a larger format
for classroom tests.

DIGITAL RESOURCES
The downloadable digital resources are for the series provided accompanied with Test Generator.
The Digital resource for Keyboard: Computer Science with Application Software, includes:

¢ Animations for the theoretical chapters such as that on operating systems, history of computers, input and
output devices, etc. that offer an interesting audio-visual element to technically complex or difficult concepts.
There are one or more modules for each such chapter which may be paused at relevant points and feedback
taken on what the children have seen, heard, and understood.

* Demo Videos that are linked to one of the Practice Times in software chapters (those chapters that describe
the features and commands available in a software), and present a step-by-step audio-visual guide to solving
the problem described in that particular Practice Time question. One or more objective type question(s) has
(have) been introduced at (a) strategic point(s) under the feature Rapid Round during the demo to encourage
children to participate in the solution to the problem. These questions could be also be used as a formative
assessment tool.

¢ Interactive Exercises The objective type questions have been made interactive in the form of pop-up screens
in which the right answer can be typed in or clicked. Clicking Submit will give you feedback, hence these
can be used as a formative assessment tool for quick evaluation.
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* Printable documents for every chapter in the form of soft copies of the worksheets and test papers given in
the Teaching Guides. The teacher is free to use either version of the worksheets and test papers as formative
assessment tools.

* Additional projects, Cyber Olympiad questions for practice, revision questions, and sample assessment papers
(in classes 6 to 8).

The Test Generator accompanying digital resources is an effective assessment tool designed to benefit teachers

by enabling them to create a variety of test papers.

It has two sections: (a) Coursebook questions (b) Questions beyond the coursebook.

Both have an extensive pool of questions including multiple choice, true or false, fill in the blanks, very short
answer, and short answer questions, as well as lab exercises wherever relevant. The Test Generator can be used
to create test papers for one or more chapters, with a mix of questions from both the sections. The wide variety
of objective and descriptive type of questions makes the tool flexible enough for teachers to employ it either for
formative or for summative assessment. Answers have also been provided for these questions to aid efficient
and effective evaluation by teachers.

COMPREHENSIVE EVALUATION

Comprehensive evaluation involves, as explained above, both the scholastic and co-scholastic aspects of a student’s
growth and development. It aims to assess the student not only in the area of pure knowledge but also in the
areas of their analytical and creative ability, as well as in their general attitudes and aptitudes.

The key features in Keyboard: Computer Science with Application Software, have been designed to provide
both scholastic and co-scholastic development.

Scholastic

* The features such as Did You Know?, Fast Forward, Top Tip, Tricky Terms, and Memory Bytes, enhance
and reinforce conceptual knowledge.

Did you Kknow? )

One point equals 1/72% of

aninch. Font dialog box Ctrl + D
e t
= Template A pre-defined design layout that saves  Scratch Area  The grey area around the
time while designing publication page where objects can be placed
Stal’ter images are Objects  The elements you place in your before insertion in the publication page
N . publication Drop Cap A text-formatting style that enlarges
backgrounds with outlines of Guides They are horizontal and vertical lines the first letter of the selected text
images, or 3D photographs,
that you can use in Tux Paint.
o
LI ]
¢ The AutoFill feature lets you quickly enter a e Filtering selectively displays rows/columns that
predefined series of data. meet the criteria specified by the user.
¢ There are two ways to create custom lists: by ¢ Conditional formatting allows you to set a
importing the list or by entering the list in the cell’s format according to the conditions you

Custom Lists dialog box. specify.
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Co-Scholastic

* The features such as Computer Manners, Projects, and the design of the practical exercises focus both on
scholastic and co-scholastic areas by creating awareness on ethical and correct use of computers, as well as
the use of computers as a tool for applying their creativity and enhancing their problem-solving skills.

PROJECTS

Type the following commands and execute it in KTurtle. Draw the figure you see on

fu 120

tr 45

fu 70

tr 90

fu 70

t1 135

go 60,250

fontsize 40
pencolor 0, 0, 255
print “This is my house”
spritehide

Find out how many rectangles there are in the figure. ..................c..ccoveeres

- "
.
KTURTLE
the canvas in the space provided.
Note: Read and enter the commands column-wise.
reset £fw 100
canvascolor 255,0,0 bw 40
pencolor 0, 255,0  tr 90
penwidth 5 fw 50
go 150,250 tr 90
fw 120 fw 20
tr 90 tr 90
fw 100 £fw 50
tr 90 tr 90
fw 120 fw 60
tr 90 tr 90
>
Application-Based Questions
a. Observe the given figure on the right and IN THE LAB

answer the following questions:
i. Which tool is selected in the figure?

ii. Name the modifier that has been used to
draw line A.

iii. Name the modifier that has been used to
draw line B.

iv. Which modifier will you use to draw
lines without any modifications?

B

Danya has to create a cartoon character using
tools available in Flash CS3. Which tool will
she use for the following purposes?
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greeting card of your own, using the various tools in Paint, for your teacher.




TEACHER’S RESOURCE

SCHEME OF WORK AND LESSON PLANS

* A Scheme of work and Lesson Plan has been devised for each chapter which details the number of periods
recommended for that chapter, the topics covered in that chapter, the recommended topic-wise allocation of
periods, the learning outcomes, and the downloadable digital resources available for that chapter.

* The total number of periods in a year for computer science has been taken at 36 assuming one period in a
week for the subject.

* Teachers may go through the lesson plan before stepping into the class. However, this is a proposed lesson
plan, and teachers are free to modify it as per their teaching styles, sequence, and requirements in respect of
the chapters.
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SCHEME OF WORK*
Topic-wise
Chapter Title | In this Chapter Allocation Learning Outcomes
of Periods
1. The Classification of 2 The student should be able to:

Computer | Computers by Size ) )

System e classify computers by size.

e differentiate amongst the different types of computers—mobile
computers, mini computers, microcomputers, mainframes, and
supercomputers.

Hardware 3 ¢ define the term, hardware.

e describe the different input devices—barcode reader, magnetic ink
character reader, etc.

e describe the different output devices—LCD Projector, Braille Printer,
Plotter.

Software 2 ¢ define the terms: software and program.

¢ explain the terms: system software, operating system, and driver.

o differentiate amongst assembler, compiler, and interpreter.

e describe the two types of application software-packages and utilities.

Computer 1 e discuss the classification of computer languages—low-level languages
Languages and high-level languages.
2. Formatting | Font Formatting 2 The student should be able to:
Data in
Excel 2013 e explain the term, font.

® recognise the functions of all the buttons in the Font group on the
HOMEE tab.

e set the cell colour, pattern, and border.

¢ apply different formatting features like font colour, text style (bold,
italics and underline), and font size.

Alignment and 2 ¢ explain the terms: Alignment and Orientation.
Orientation of e recall the functions of all the buttons in the Alignment group on the
Data HOME tab.

* appropriately apply the different types of text alignment in a cell.

e orient data in a cell at different angles.

¢ effectively use the Wrap Text and Merge & Centre features.

Number 1 e recall the use of all the buttons in the Number group on the HOME tab.
Formatting e format numeric data.
Cell Styles 1 ¢ explain why cell styles are required.
® apply a cell style.
3. Advanced | AutoFill 2 The student should be able to:
Features of
Excel 2013 ¢ explain the working of the AutoFill handle.
e use the AutoFill options effectively.
e create, edit, or delete a custom list.
Flash Fill 1 e describe what the Flash Fill feature does.

differentiate between AutoFill and Flash Fill.

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
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xiii

Topic-wise
Chapter Title | In this Chapter Allocation Learning Outcomes
of Periods
Sorting 1 ¢ explain why sorting is required.
¢ sort using single or multiple columns.
e organise data into levels.
Filtering 1 ¢ describe what filtering means.
¢ demonstrate how filtering is applied.
¢ explain the different criteria that can be used for filtering.
Conditional 1 ¢ explain the meaning of conditional formatting.
Formatting
o effectively apply conditional formatting.
¢ explain how selected rows are highlighted.
More Sorting and 1 e sort or filter data based on cell colour.
Filtering
4. Introducing | Starting Publisher 1 The student should be able to:
Publisher 2013
2013 ¢ start Publisher 2013.
¢ explain the difference between built-in and online templates.
¢ customise the template.
e identify the different parts of the Publisher interface.
Publisher Interface
Working with 25 ¢ insert text boxes.
Publisher 2013 ¢ format text and text boxes.
¢ save publications with .pdf and .pub extensions.
e print, close, and exit a publication.
Creating a New 0.5 * create your own publication design from scratch.
Blank Publication
Connecting Text 1 ® connect text boxes.
Boxes
Typography 1 e explain the Drop Cap feature.
¢ describe Number Styles, Stylistic Sets, Swash, and Ligatures.
5. Graphics in | Working with 3 The student should be able to:
Publisher Pictures
2013 ¢ recall the different ways of inserting pictures in a publication.
® crop a picture.
¢ wrap text in different ways around a picture.
¢ apply a picture style.
* move, align and resize a picture.
¢ explain what a caption means.
¢ add a caption to a picture.
¢ set a picture as background.
Scratch Area 2 ¢ explain what the scratch area and thumbnails are.
¢ select multiple objects in scratch area.
* arrange pictures as thumbnails and swap pictures.
Working with 1 e insert shapes in a publication.
Shapes * resize and rotate objects, fill shapes style shapes, apply shape outline

and shape effects.

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
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Chapter Title

In this Chapter

Topic-wise
Allocation
of Periods

Learning Outcomes

Working with
Building Blocks

1

describe what building blocks are.
define the four types of building blocks.

insert building blocks in a publication.

6. Basics of
MS Small
Basic

Basics of Small
Basic

The student should be able to:

start a Small Basic program.
identify the various components of the main screen.

write a simple program and explain how to save, execute and open a
program.

Elements of Small
Basic

explain the rules of Small Basic programming.
define constants and variables.

differentiate between the two types of constants.
list the rules for naming variables.

differentiate between numeric and string variables.
explain what an assignment statement is.

define the terms: Operators and Expression.
describe the types of operators with examples.
define concatenation.

write comments in a program.

define an object, a property, and a method.
differentiate between the Write ( ) and WriteLine( ) methods.

explain the TextWindow object in detail.
differentiate between Read ( ) and ReadNumber

describe math library functions with examples.

( ) methods.

Conditional
Statements in
Small Basic

describe the different formats of the If statement.
differentiate between If...Then...Else and If...Then...Elself statements.
demonstrate the use of the If statement taking daily life examples.

7. The Internet
as a Post
Office

Internet Terms
and Addresses

The student should be able to:

define the following terms:
- ISP

— Modem

— Web page

— Web Browser

— Website

- WWW

— Home page
- URL

differentiate between Number Addressing and Letter Addressing
systems with examples.

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
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Topic-wise
Chapter Title | In this Chapter Allocation Learning Outcomes
of Periods
Email Services 2 e list the advantages of email.
¢ explain the parts of an email address.
e list the various features of an email service.
* demonstrate how to open an email account.
® demonstrate how to compose and send emails.
¢ demonstrate how to create signatures.
¢ explain why it is important to sign out properly.
Information 2 ¢ explain what a search engine is.
Retrieval ¢ demonstrate how to use a search engine to find information.
Education ¢ explain how the Internet is a great tool for education.
Through the e search for people on the Internet
Internet
Finding People on
the Internet
8. Introduc- Getting Started 3 The student should be able to:
tion to Flash | with Flash
CS3 ¢ explain the use of the Flash software.
® demonstrate how to start Flash CS3.
¢ explain the components of the Flash window.
¢ explain different areas of the Tools Panel.
¢ explain the importance of the Property Inspector
* explain the use of rulers
¢ demonstrate how to create a new Flash document
* demonstrate how to set document properties
¢ demonstrate how to save and open a file
Drawing Modes in 1 e differentiate between Merge Drawing mode and Object Drawing mode
Flash in Flash
Selection Tools 2 ® demonstrate how to use the different selection tools—Arrow tool, Lasso
tool
9. Drawing Drawing Tools 5 The student should be able to:
Tools in
Flash ® demonstrate the use of the Line Tool, Rectangle Tool, Rectangle
Primitive Tool, Oval Tool, Oval Primitive Tool, PolyStar Tool, Pencil
Tool, Brush Tool, Paint Bucket Tool, Ink Bottle Tool, Eraser Tool.
e differentiate between the Rectangle Tool and the Primitive Rectangle
Tool
e differentiate between the Oval Tool and the Primitive Oval Tool.
® create a new gradient.
e demonstrate how to use the Ink Bottle Tool, and the Eraser Tool.
Reshaping Lines 1 * demonstrate how to reshape lines using the Arrow Tool.
and Shapes
10. Creating Creating Symbols 2 The student should be able to:
Anima-
tions in ¢ explain the need for creating Symbols.
Flash CS3 e convert a drawing into a Symbol.

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
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Topic-wise
Chapter Title | In this Chapter Allocation Learning Outcomes
of Periods
Understanding the 2 ¢ explain the components of the Timeline window.
Timeline ¢ differentiate between frames and keyframes.
¢ insert frames and keyframes.
¢ delete a frame.
Creating 4 e create frame-by-frame animations.
Animations e create a motion tween.
e create a shape tween.

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
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LESSON PLANS*
Chapter 1 The Computer System

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), safety pins, a sheet of paper, cut out alphabets, saved pictures
of different computers

Introduction (5 minutes)

Start off the lesson by showing students images of different types of computers (by size classification) already
saved in the laptop. Encourage them to share whatever information they have regarding the images, before
giving them a brief introduction on the history of computers and where they were used. You may also ask
students to name a few peripheral devices and software that they have seen or used before.

Explanation (25 minutes)

Briefly describe input and output devices and explain in detail the devices mentioned in the chapter. Next
ask the students to silently go through ‘'SOFTWARE’ heading in the chapter. You can then write down the
names of a few well known software on the board, for example Windows 10, MS Word, Norton, Linux
etc., and ask students to categorise them either as system software or application software. Following this
activity, you can thoroughly explain the concept of software to students.

In order to demonstrate the workings of a braille printer, you can ask students to pin cut out alphabets on
sheets of paper, using a safety pin. They can exchange their papers with their seatmates, run their fingers
over the pinned alphabet, and try to identify the alphabet. This activity will help them understand how
braille printers aid the blind in reading.

You can assign any of the following tasks for classwork.
* Exercises

In the Lab
Application Based Questions

¢ Group Project

Assessment
Students’ learning should be assessed on Bloom's taxonomy model, as well as on their class participation,
enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

¢ classify computers by size.

o differentiate among the different types of computers-mobile computers, minicomputers,
microcomputers, mainframes, and supercomputers.

¢ define the term hardware.

* describe the different input devices- barcode readers, magnetic ink character reader, etc.

* describe the different output devices LCD projector, braille printer, plotter.

¢ define the terms: software and program.

¢ explain the terms: system software, operating software, and driver.

* differentiate amongst assembler, compiler, and interpreter.

¢ describe the two types of application software-packages and utilities.

¢ discuss the classification of computer languages: low-level languages and high-level languages.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 2 Formatting Data in Excel 2013

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), a sample table of daily activities on excel sheet saved on
your laptop, MS Excel software, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend
the concepts taught in class.

Introduction (8 minutes)

You may start off the lesson by asking students to draw a timetable of their daily activities from Monday
to Friday, starting from the time they reach home to the time they go to bed. Give them around 3 minutes
for this activity (a rough sketch will be good enough). After they are done, show students the MS Excel
table saved in your laptop and ask them to identify the software used to create it. You may then have a
brief discussion with your students about the advantages of using MS Excel. Encourage them to share
whatever knowledge they have regarding the software.

Explanation (25 minutes)

Let students read from the textbook. You may take your students to the computer lab and show them
the different ways of formatting text and numbers on MS Excel. Have them perform the practice time
questions in the computer lab. (In case there is a shortage of computers, then divide the practice time
questions into 3 parts. Divide the students in groups of 3 and have them practice different parts of a
question.)

In order to test their knowledge, at the end of the session you may format text and numbers in different
ways and ask students to identify the type of formatting that has been done. You can then assign any of
the following tasks for classwork.

¢ Exercises

¢ InthelLab
¢ Application Based Questions
*  Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
¢ explain the term ‘font’.

* recognise the functions of all the buttons in the font group on the home tab.
¢ set the cell colour, pattern, and border.

¢ apply different formatting features like font colour, text style (bold, italics, and underline), and
font size.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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¢ explain the terms: alignment and orientation.

¢ recall the functions of all the buttons in the alignment group on the home tab.
* appropriately apply the different types of text alignment in a cell.

¢ orient data in a cell at different angles.

o effectively use the text wrap and merge & centre features.

¢ recall the use of all the buttons in the number group on the home tab.

¢ format numeric data.

¢ explain why cell styles are required.

¢ apply a cell style.

Conclusion (7 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Ask about the
feature they like the most in MS Excel program. Have a discussion on any one on the topics mentioned
in the teacher’s notes, given at the end of the chapter.

Chapter 3 Advanced Features of excel 2013

Time for each lesson: 40 minutes
Resources: a laptop, a projector (if available), MS Excel, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend
the concepts taught in class.

Introduction (7 minutes)

You may commence the session by having a discussion with your students about the reading material
that was assigned to them. Encourage them to share their doubts and discuss anything that they found
interesting in the chapter. You can also conduct an activity in class by writing a few names on the board
and asking students to note them down on a piece of paper, but in ascending order. You can wind up the
introduction by explaining how MS Excel can make this task, and many other tasks, a lot easier by using
a few simple commands.

Explanation (25 minutes)

In the computer lab, demonstrate how the different features work in MS Excel (you may use a projector
so that all students are able to view the screen properly). You can also mention the advantages of each
feature alongside. For example, how Flash Fill is helpful in that it helps save time and minimises errors
etc. Have the students perform the practice questions in the computer lab as part of their classwork.
Elicit responses from them on how they think MS Excel has made working with tables and numbers a lot
easier. Finally you can have them come up with 3 other uses of MS Excel.

You can assign any of the following tasks for classwork (other than practice work).
Exercises

In the Lab

Application Based Questions

Group Project

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.

OXFORD

UNIVERSITY PRESS



TEACHER’S RESOURCE

Assessment

Students’ learning should be assessed on Bloom's taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
* explain the working of the autofill handle.

¢ use the autofill options effectively.

e create, edit, or delete a custom list.

¢ describe what the flash fill feature does.

¢ differentiate between autofill and flash fill.

¢ explain why sorting is required.

¢ sort using single or multiple columns.

* organise data into levels.

* describe what filtering is applied.

¢ explain the different criteria that can be used for filtering.
¢ explain the meaning of conditional formatting.
¢ effectively apply conditional formatting.

¢ explain how selected rows are highlighted.

¢ sort or filter data based on cell colour.

Conclusion (8 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 4 Introducing Publisher 2013

Time for each lesson: 40 minutes
Resources: a laptop, a projector (if available), Publisher 2013, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend
the concepts taught in class.

Introduction (7 minutes)

You may start off the lesson by discussing how celebrations and exchanging cards have become a norm
particularly on special events like birthdays, weddings, final exam results, etc. Have students share ideas
on what type of cards they exchange on their birthdays. And from there you can introduce Publisher
2013 as a software that helps users create different documents, including cards.

Explanation (25 minutes)

In the computer lab explain to students how Publisher 2013 can be used to create a variety of documents
like sports team banners, event flyers, certificate awards, etc. Make sure that students are able to relate
with every example that you give. You may then demonstrate the workings of Publisher 2013, how
users have the option of making their own publication from scratch or using one of the pre-designed
templates, or how text can be included in the publication and formatted as well.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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It is recommended that you have students perform Practice Time questions as part of their classwork.
This will allow them to practice what they’ve learnt during the lesson.

You can assign any of the following tasks for classwork (other than practice work).
¢ Exercises

In the Lab
¢ Application Based Questions

¢ Group Project
Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
¢ start publisher 2013.

¢ explain the difference between built-in and online templates.
¢ customise the template.

¢ identify the different parts of the publisher interface.

* insert text boxes.

¢ format text and text boxes.

¢ save publications with .pdf and .pub extensions.

* print, close, and exit a publication.

* create your own publication design from scratch.

* connect text boxes.

¢ explain the drop cap feature.

* describe number styles, stylistic sets, swash, and ligatures.

Conclusion (8 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 5 Graphics in Publisher 2013

Time for each lesson: 40 minutes
Resources: a laptop, a projector (if available), Publisher 2013, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend
the concepts taught in class.

Introduction (5 minutes)

You may start off the lesson by briefly recapping the important points of the previous lesson. You
can ensure that students remain engaged in this discussion by encouraging them to briefly recap the
previous chapter in their own words.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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Explanation (25 minutes)

In the computer lab explain to students how they can also work with images on Publisher 2013.
Thoroughly describe the various ways in which images can be formatted including aligning, resizing,
styling, scratch areas, thumbnails, shapes, building blocks etc. Ensure that students are given ample time
to perform some of these function on their own. You can also ask students to perform the Practice time
questions individually or in groups of 3. All of this will allow students to practice what they’ve learnt
during the lesson.

You can assign any of the following tasks for classwork (other than practice work).
¢ EXxercises

In the Lab
¢ Application Based Questions

*  Group Project
Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

* recall the different ways of inserting pictures in a publication.
® crop a picture.

* wrap text in different ways around a picture.

e apply a picture style.

* move, align and resize a picture.

¢ explain what a caption means.

* add a caption to a picture.

¢ seta picture as a background.

¢ explain what a scratch area and thumbnails are.

¢ select multiple objects in scratch area.

* arrange pictures as thumbnails and swap pictures.

* insert shapes in a publication.

* resize and rotate objects, fill shapes, style shapes, apply shape outline and shape effects.
¢ describe what building blocks are.

¢ define the four types of building blocks.

¢ insert building blocks in a publication.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 6 Basics of MS Small Basic
Time for each lesson: 40 minutes
Resources: a laptop, a projector (if available), MS Small Basic, computer lab

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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Note: Ask students to go through the chapter at home once so that they are able to better understand the
concepts taught in class.

Introduction (5 minutes)

You may begin your class by holding a small discussion with students regarding what the reading
material that was assigned to them. Acknowledge the fact that MS Small Basic is a new concept to them
and that at the end of this lesson they will be able to write a few codes themselves.

Explanation (25 minutes)

In the computer lab, introduce students to MS Small Basic. Explain to them the various terminologies
used in the chapter like constants, variables, operators, expressions, arithmetic and logical operators,
comment, object, property, statement etc. Also, ensure that students are aware of the difference between
Write () and WriteLine (), and Read () and ReadNumber ().

You may give students the time to perform the examples given in the chapter. You can also ask them
to perform the Practice time questions individually or in groups of 3. All of this will allow students to
practice what they’ve learnt during the lesson.

You can assign any of the following tasks for classwork (other than practice work).
¢ Exercises

¢ InthelLab
¢ Application Based Questions
¢ Group Project

Assessment

Students’ learning should be assessed on Bloom'’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
¢ start a small basic program.

¢ identify the various components of the main screen.

* write a simple program and explain how to save, execute, and open a program.
¢ explain the rules of small basic programming.

¢ define constants and variables.

¢ differentiate between the two types of constants.

¢ list the rules for naming variables.

¢ differentiate between numeric and string variables.

¢ explain what an assignment statement is.

¢ define the terms: operators and expression.

* describe the types of operators with examples.

¢ define concatenation.

¢ write comments in a program.

¢ define an object, a property, and a method.

e differentiate between the write () and writeline () methods.
¢ explain the textwindow object in detail.

e differentiate between read () and readnumber () methods.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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¢ describe math library functions with examples.

e describe the different formats of the if statement.

e differentiate between if...then...else and if...then...elseif statements.
¢ demonstrate the use of the If statement taking daily life examples.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 7 The Internet as a Post Office

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), computer lab, Internet, any email service e.g. Gmail, Yahoo
mail, Hotmail, etc.

Introduction (5 minutes)

Start off the lesson by asking students what activities they carry out on the Internet. Introduce to them
to the concept of Internet Service Providers (ISP). To help them better understand this concept, you may
ask them which internet service provider they use at home while naming a few like PTCL, Storm Fibre
etc. Also explain the concept of IP addresses, URL and domain names.

Explanation (25 minutes)

Explain to students the concept of emails and how they have made life easier. You may compare email
services with traditional post letters to further elaborate the advantages of emails.

Next you may take your students to the computer lab and demonstrate how to create an email address.
Ask them to create their own email addresses and talk them through the process of sending emails to
their friends. Make sure that they’re given ample time for this activity. You can also ask them to perform
the Practice time questions individually or in groups of 3. All of this will allow students to practice what
they’ve learnt during the lesson. You can assign any of the following tasks for classwork.

e Exercises

e Inthe Lab

¢ Application Based Questions
¢ Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
¢ define the following terms:

o ISP

o Modem

o Web Page

o Web Browser

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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Website
WWW
Home page
URL

© O o O

¢ differentiate between number addressing and letter addressing systems with examples.
¢ list the advantages of email.

¢ explain the parts of an email address.

¢ list the various features of an email service.

¢ demonstrate how to open an email account.

¢ demonstrate how to compose and send emails.

* demonstrate how to create signatures.

¢ explain why it is important to sign out properly.

¢ explain what a search engine is.

¢ demonstrate how to use a search engine to find information.
¢ explain how the internet is a great tool for education.

¢ search for people on the Internet.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 8 Introduction to Flash CS3

Time for each lesson: 40 minutes

Resources: a laptop, a projector, Flash CS3, computer lab, a short video containing any animations,
saved on your laptop

Introduction (5 minutes)

Start the lesson off by showing students a short animated video. You can then initiate a discussion by
asking students how they think the video was made. And from there, introduce them to the chapter
explaining that Flash CS3 is one such software that allows users to create attractive web pages by
combining audio, images, videos, and animations.

Explanation (25 minutes)

In this lesson, you will only need to introduce your students to the various properties and terminologies
of Flash CS3. You may take them to the computer lab and show them the software. Explain in detail,
what a tool panel is and all the different tools that it contains and their functions. Similarly, elaborate on
the different selection tools and where each one of them is used. And finally, explain to them the purpose
of the Property Inspector and what it does.

You can also ask students to perform the Group Project and some other relevant questions from ‘In The

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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Lab’ either individually or in groups of 3. All of this will allow them to retain what they have learnt
during the lesson.

You can assign any of the following tasks for classwork.
* Exercises

In the Lab
¢ Application Based Questions

¢ Group Project
Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
¢ explain the use of the flash software.

¢ demonstrate how to start flash CS3.

¢ explain the components of the flash window.

¢ explain different areas of the tools panel.

¢ explain the importance of the property inspector.

¢ explain the use of rulers.

¢ demonstrate how to create a new flash document.

¢ demonstrate how to set document properties.

¢ demonstrate how to save and open a file.

¢ differentiate between merge drawing mode and object drawing mode in flash.
e demonstrate how to use the different selection tools: arrow tool, lasso tool.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 9 Drawing Tools in Flash CS3

Time for each lesson: 40 minutes

Resources: a laptop, a projector, Flash CS3, computer lab, a short video containing any animations,
saved on your laptop

Introduction (5 minutes)

You may start off the lesson by asking students to briefly recap all the important points of the previous
lesson. This will help ensure that students remain engaged in this discussion. Encourage them to share
any other information that they have come across regarding Flash CS3.

Explanation (25 minutes)

In this lesson, you will have to focus on the drawing tools of Flash CS3. It is important that students
practice all of the tools mentioned in the chapter and do not have any confusion regarding tool names

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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and functions. You may take them to the computer lab and show them the tools and their workings
before asking them to practice it on their own.

You can ask students to perform the Practice Time questions to ensure that they practice what they’'ve
learnt. Along with this, practicing the Group Project and some other relevant questions from ‘In The Lab’
either individually or in groups of 3 will also help them retain what they have learnt during the lesson.

You can assign any of the following tasks for classwork.
¢ Exercises

In the Lab

¢ Application Based Questions

¢ Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
* demonstrate the use of the line tool, rectangle tool, rectangle primitive tool, oval tool, oval
primitive tool, polystar tool, pencil tool, brush tool, paint bucket tool, ink bottle tool, eraser tool.

¢ differentiate between the rectangle tool and the primitive rectangle tool.
» differentiate between the oval tool and the primitive oval tool.

* create a new gradient.

¢ demonstrate how to use the ink bottle tool and the eraser tool.

¢ demonstrate how to reshape lines using the Arrow Tool.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 10 Creating Animations in Flash CS3

Time for each lesson: 40 minutes

Resources: a laptop, a projector, Flash CS3, computer lab, a short video containing any animations
(saved on your laptop)

Introduction (5 minutes)

You may start off the lesson by asking students to briefly recap all the important points of both the
previous lessons (Chapters 8 and 9). Make sure they remain engaged in the discussion. Encourage them
to share any other information that they have come across regarding Flash CS3.

Explanation (25 minutes)

For this lesson, you will again have to take your students to the computer lab. They will need proper
practice of all the new functions introduced in this chapter including symbols, timeline, and frames.
Ensure that students are able to differentiate between motion tweening and shape tweening.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.

OXFORD

UNIVERSITY PRESS



TEACHER’S RESOURCE

You can ask them to perform the Practice Time questions to ensure that they practice what they’ve learnt.
Along with this, practicing the Group Project and some other relevant questions from ‘In The Lab” either
individually or in groups of 3 will also help them retain what they’ve learnt during the lesson.

You can assign any of the following tasks for classwork.
* Exercises

e Inthe Lab
¢ Application Based Questions
*  Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class
participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
¢ explain the components of the timeline window.

¢ differentiate between frames and keyframes.
¢ insert frames and keyframes.

¢ delete a frame.

* create frame-by-frame animations.

® create a motion tween.

¢ create a shape tween.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a
discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
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ANSWER KEY TO THE COURSEBOOK

The complete Answer Key to the Coursebook Exercises has been given here including that for the In the Lab
questions, Worksheets/ Assessment papers, Group Projects, Revision Questions, and the Cyber Olympiad
Questions.

These are only suggested answers, and variations are possible especially for the open-ended questions,
such as the descriptive questions, and those of In the Lab. Teachers may use their discretion while checking
the answers provided by the students, and give them marks based on conceptual accuracy and conceptual
clarity.

Teachers should consider the following, while conducting the Group Project activity:

i

ii.

iii.

iv.

Vi.

Groups should not be larger than five members; pair work obviously means two people working together;
it is always a good idea to make groups of mixed ability.

Be very clear in your expectations from the group, this means telling them clearly what the assignment
is about and what you expect to be submitted.

Make it clear to the students that part of their marks will depend on how well they work with each other
and that you expect all of them to be involved in the project.

Get the students to select their own group leader; if you see that a group is reluctant to do so, you could
assign one; also remind the students that they need to listen to the group leader.

Let the group leader divide the tasks that need to be accomplished.

As a teacher, your role should be to observe what each group is doing, how well they are collaborating
with each other and offer advice if needed; the focus should be to encourage the students to work without
too much input from the teacher.
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Chapter 1 The Computer System

1. a. iii. C++ b. iv. Package c. ii. Bar Code reader
d. i Barcode e. ii. Bank cheques

DESCRIPTIVE TYPE QUESTIONS

1. a. iMagnetic Ink Character Recognition ii. Optical Mark Reader
A program is a sequence of step-by-step instructions to perform a particular task.

c. Anoperating system is the master control program that runs the computer. It controls the flow of signals
from the central processing unit to the various parts of a computer. Some popular operating systems are
Windows 7 and iOS.

d. Assembly language is a computer language that uses words made with letters of the English alphabet.
Each instruction to the computer is written using a letter combination.

Machine language is the language that the computer understands and can execute directly without
translation. It is written in the form of a long string of 0s and 1s.

e. A compileris a program that translates a high-level computer language program into machine language
program. The compiler first reads the whole program and then at one go translates it into machine
language. It reports the program errors to the user along with the line numbers on which the error has
occurred. The translated program called the object program is saved permanently for future use.

An interpreter is a program that translates one statement of a high-level language program into machine
code and executes it. It then does the same for the next statement and proceeds in this way until all the
statements in the program have been translated and executed. An interpreter is a smaller program than
a compiler. The object code produced by the interpreter is not saved. If the same instruction is needed
later, the process will be repeated.

f.  AnLCD projector shows the output from a computer on a large screen. It is commonly used for displaying
presentations during meetings and conferences.

g. The answer should include the following aspects:
e A brief discussion on the reduction in size over time

¢ The technological advances which have led to the making of smaller more portable computers which
are just as powerful, if not more, than the earlier ones.

* Increased processing speeds, storage capacity has made it possible for computers to be used in all
walks of life, examples could include using laptops for office work such as making presentations,
online shopping, smart phones to listen to music, play games, send and receive emails, e-readers
such as Kindle for reading books online.

* Now computers are a part of daily lives, examples should include mention of personal computers,
laptops, palm tops

e Smart cards hold a great deal of personal information about an individual. Examine the hazards of
having so much information in one place?

h  There is no doubt that smart cards have made life a lot easier. By holding a great deal of information,
smart cards have made all aspects of life easier to cope with by putting all of your personal information
on a single chip. But the use of smart cards is not without its dangers. A smart card contains much of
your personal information and if stolen it can be used to access personal details such as your personal
identity number or credit card number and then used to get financial advantage or commit some fraud;
this is what is called identity theft and can cause the actual owner of the card a lot of trouble. Or worse
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yet, they could commit another crime and leave your card there, and when authorities find it, you are
the one who is liable to get into trouble.

Itis notimportant what shapes the students use. Their answer should exhibit some level of comprehension.
The program should ask the user to input a set of marks for different subjects and then add them up
and display the output. Below is an example of a program asking for two marks; students could show

more.

Begin Program

]

Display on screen: Please enter
marks for Mathematics.

—

User enters marks

4

Display on screen: Please enter
marks for English.

o

Add marks

!

Display marks

APPLICATION-BASED QUESTIONS

A barcode reader is being used to scan a barcode.

Barcode reader
Biscuit packet, clothes

The sheet shown is called an OMR sheet.
An OMR (Optical Mark Reader).
These types of sheets are generally used for answer sheets of exams that have multiple choice questions.

The boxes or circles in the sheet can be filled with a dark pencil or ink.
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€ | Hardware Software
Barcode reader compiler
Card reader driver
Plotters Windows

d. i. Windows 7 is a system software and Quick Heal is an application software.
ii. When the computer is switched ON, the operating system is first loaded onto the memory.

IN THE LAB

1. Students should be encouraged to find out the operating system installed on their computer. These might
be Windows?7, Windows8, etc. Other operating systems are Windows NT, Android etc.

2. List of Application Software

Microsoft Word, Microsoft PowerPoint, Microsoft Excel, Adobe Photoshop, Flash, Dreamweaver, Access
2013, VLC Media Player, Picasa, and Calculator.

List of Utility Programs
Antivirus software—Quick Heal, Screen savers, Wallpapers, Backup Software, and Disk Cleaner.

3. Students should be encouraged to search for images and information on different input and output devices
in newspapers, magazines, and on the Internet. They can collect these pictures and create a chart.

4. Antivirus software installed in my computer—Quick Heal.

Examples of antivirus software—McAfee, Norton, Kaspersky, Avast, Avira.

GROUP PROJECT

1. The hardware and software components for making standardised paper are given below.

i. Optical mark reader—to read the marks made by the students
ii CPU-to store the scanned document
iii Monitor—to see the results on the screen

iv  Printer-to print the results
The components required for reading a credit/debit card are:

e Smart card reader—to read the card and see when the Rs 10,000 limit has been crossed
* Application software which can read the smart card
The following hardware and software components are required to setup a computer system.

e  Monitor

e Keyboard
e CPU

e Mouse

e Printer

e C(Cables

e  Windows software

Note: Students can include other input and output devices. What we are looking for is whether students
can identity various hardware/software available for different tasks as described in the book.
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Chapter 2 Formatting Data in Excel 2013

OBJECTIVE TYPE QUESTIONS

iv. Left b. iv.all of these c. ii. Wrap Text
iv. All of these e. 1ii.54,612.000

DESCRIPTIVE TYPE QUESTIONS

Wrap Text: You can make the text wrap within the same cell. The data is confined to the cell but is
displayed in multiple lines.

Merge & Centre: You can merge adjacent cells into one large cell. The text will be centre-aligned in the
single merged cell.

Number group of the HOME tab shows the various formatting type options for numbers in the Number

Format drop down list. To add the Rupee symbol do the following:

i. Click the arrow next to Accounting Number Format and select More Accounting Formats. The
Format Cells dialog box appears.

ii. Select the Symbol as PKR English (UK) and click OK. The Rupee symbol appears before the number
in cell.

Select the cells A1:E5 and click the arrow next to Fill Color to choose a colour. The colour will be set as
the background of the selected cells.

The buttons in the lower row of the Number group of the HOME tab are:
Accounting Number format, Percent Style, Comma Style, Increase Decimal, and
Decrease Decimal.

To format the data to 25%:

i. Type the number in the cell. Select the cell.

ii. Click the drop down menu arrow of the Orientation button in the Alignment group on the HOME
tab.

iii. The drop down menu appears.

iv. Click Format Cell Alignment option.

v. The Format Cells dialog box appears with the Alignment tab selected.

vi. Under Orientation, using the mouse, drag the pointer to 25° angle.

vii. The text in the selected cell will appear at this angle.

Formatting allows the user to change the way the content of a cell appears in Excel but not change the
exact cell value. Excel allows the user to format both text and numbers. This is important because it
allows for differentiation between different types of data. The user can highlight the important parts of
the worksheet using background colours, different styling of font, or increasing the font size, or even
using different fonts. In the same way; since Excel was primarily created to deal with large calculations;
number formatting provides the user with a selection of options to make the Excel sheet more presentable
and useful. For example, the user can assign the number of decimal places required when dealing with
large numbers. The user can also access percentages, scientific notations, fractions, and give symbols
for different currencies, etc. All this allows the finished worksheet to look more presentable and easier
to understand.

So the advantages derived from the formatting options include ease of readability, better organisation,
a more professional look, and a better understanding of large and complex numerical data.
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g. A student might choose to use font formatting because it allows for more creativity and customisation,

i.e. applying only those formatting commands which they really want. At the end of the day, though,
they will only be formatting fonts which is just a small part of the formatting tools available.
The students who choose cell styling are more correct, as not only does it save time in formatting the
contents of a cell, the fact that it deals with all aspects of formatting such as font, alignment, type of
numbers to use, type of border, cell fill, etc., makes it a more complete solution. Also, Excel allows the
user to define their cell style.

h. Presentations will vary. What you should look for is an application of most of the commands that were
taught in the chapter. Check to see if the student has used:

a. Font formatting (size, bold, italic, underline, colour, type, alignment)
b. Cell borders and colours
c. Number formatting

APPLICATION-BASED QUESTIONS

Type the text as shown in the figure. Click the HOME tab and do the following:
i. Select cells A1:D1 and do the following;:

¢ Inthe Alignment group, click the Centre button.

* In the Font group, click the Bold button. Click the down-arrow of the Underline button and select
the Double Underline option. Click the down-arrow of the Fill Color and select yellow colour from
the menu.

ii. Select cells A2:Ab. Press the Ctrl key and select cells C2:D5. Click the Centre button in the Alignment
group.

iii. Select the cells B2:B5. In the Font group, click the Italics button.

iv. Select the cells A1:D5. Click the Borders drop down menu arrow of the Font group. Select All Borders
from the menu.

i. A2:C2 - Orientation

ii. Wrap Text and Centre
It can be applied manually by clicking Alt + Enter key.

i. B3:E3 - Horizontal Centre Alignment
A4:A6 - Horizontal Left Alignment

ii. Accounting formats

i. Click the HOME tab. In the Font group, click the drop down menu arrow of Fill Color button. The drop
down menu appears. Select the pink colour.

Click the HOME tab. In the Font group, click the drop down menu arrow of Borders button. A drop

down menu appears. Select the blue colour from the Line Color sub menu.

ii. Select the text and in the Font group on the HOME tab, click the Subscript button.

IN THE LAB

Type the text as shown in the figure. Click the HOME tab and do the following:

a. Select cells A1:C1. In the Alignment group, click Merge & Centre. In the Font group, click Bold.

b. Select cells A2:C2. Click Centre in the Alignment group, and Bold in the Font group. Similarly, select
cells B3:B18 and click Centre in the Alignment group.

c. Select the cells A3:C18. Click the drop down menu arrow of Fill Color. Select the green colour from the
menu.
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d. Selectthe cells A1:C18. Click Borders drop down menu arrow in the Font group. Select All Borders from
the menu.
2. Type the text as shown in the figure. Click the HOME tab and do the following:

a. Select cells A1:C1. In the Alignment group, click Merge & Centre. In the Font group, click Bold.
Select cells A2:C2. In the Alignment group, click Wrap Text and Centre. In the Font group click Bold.
Select cells A3:A10. In the Font group, click Italics.

Select cells B3:C10. In the Alignment group, click Centre.
Select cells A1:C10. In the Font group, click the drop down menu arrow of the Borders button and select
All Borders from the menu that appears.
3. Type the text as shown in the figure. Click HOME tab and do the following:
a. Select cells A1:D1. In the Alignment group, click the Merge & Centre.

® an o

Select cells A2:D2. In the Alignment group, click Centre.

Select cells A1:D2. In the Font group, click Bold button.

Select cells A3:D6. In the Alignment group, click Wrap Text.

Select cells A1:D6. In the Font group, set the Font to Verdana and Font Size to 12. Click the drop down
menu arrow of the Borders button and select All Borders from the menu that appears.

© oo o

4. Type the text as shown in the figure. The numeric data is entered without decimal point, comma, zero after

the decimal point, and currency symbol. Click the HOME tab and do the following;:

a. Select cells A1:El. In the Alignment group, click Merge & Centre.

b. Select cells A2:E2. In the Alignment group, click Centre.

c. Select cells A1:E2. In the Font group, click Bold. Click the drop down arrow of Fill Color. Select the
desired colour from the menu that appears.

d. Select cells A3:A7. In the Alignment group, click Centre.

e. Select cells A3:E7. In the Font group click the Fill Color drop down menu arrow and select the desired
colour.

f.  Select the cells C3:E7. Select Accounting format in Number group. Select Symbol as English. Set Decimal
places: to 2. Use the Comma Style button to set comma as thousands separator.

g. Select cells A1:E7. In the Font group, set the Font to Tahoma and Font Size to 12. Click the drop down
menu arrow of the Borders button and select All Borders from the menu that appears.

GROUP PROJECT

Begin with dividing the class into groups. It is advisable to create the groups in such a way that all groups
consist of students with different capabilities. There should be no more than five students in a group. Ask all
groups to select their leaders, who should then assign each group member a specific task in relation to the
worksheet.

In order to facilitate the process, provide the students with a mark sheet which will give them more time to
focus on the practical work.

Clearly define what you will be looking for in the final submissions. This should include the ability to apply
font formatting commands, cell styling commands, colour manipulation, and borders.

The final submission should include the names of the group members and the tasks assigned to them.
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Chapter 3 Advanced Features of Excel 2013

OBJECTIVE TYPE QUESTIONS

1. a. ii. Flash Fill b. i. Filter is applied c. iii. bothiandii
d. iii. Styles e. iv.+

DESCRIPTIVE TYPE QUESTIONS

1. a. Youcanadd a custom list to Excel 2013 by importing a list of items through the following steps:

i.  On the worksheet, type the data and select the list.

ii. Click the File tab, and then click Options. The Excel Options dialog box appears.

iii. In dialog box, click Advanced and then under General, click the Edit Custom Lists button.

iv. The Custom Lists dialog box appears. Verify that the cell reference of the list of items that you selected
gets filled in the Import list from cells text box, and then click Import. The entire list gets added to
the List entries and Custom lists boxes.

v. Click OK on both the dialog boxes.

b. Custom filtering can be applied in the following manner:
i. Point to Number Filters in the AutoFilter drop down menu of the column Marks. A submenu
appears. Choose Greater Than (>).
ii. Click Custom Filter. This will open the Custom AutoFilter dialog box.
iii. To display only those rows where the data is greater than 500, fill in the value in the dialog box and
click OK. The filtered rows that satisfy the condition will be displayed in the worksheet.

c. The students should be able to demonstrate how Excel allows users to deal with large amounts of data.
Actions like copy/pasting or re-typing data over and over again are eliminated through the Autofill
command. The Autofill command provides users with the option to define what needs to be filled in
and then apply it to a large number of cells. This way a range of cells can automatically be filled in with
a series of data. This reduces the chance of error and also speeds up the work. Similarly, the Flash Fill
command is also very useful in that it uses built in logic to complete cell entries, thereby saving the user
the time to do so. For example, if three cells have first, middle, and third names in them and the user
has to type the full name in the fourth cell, using Flash Fill means it only has to be typed it the first time.
After that the software will suggest the full name for all other entries using logic.

d. The students should be able to identify clearly the difference between the two tools—sorting (arranging
data in a specific order) and filtering (blocking out data that you do not want to see). In this case, filtering
would be the best option because Zaid can apply the filter to the column containing the last names and
then filter out the ones that are not required. This would leave a list of only those people with the same
last name, e.g. Haroon, making it easier to find the customer.

e. Itwould be best if this question is assigned during practical work. The students should be given enough
time to complete the work and then the teacher can go around and check if the three requirements have
been met. For (a) the sort command should have been used correctly; (b) will require filtering and then
applying the colour red; (c) the student should apply the filter command using the text filter begins with.
See the screen shots below:
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APPLICATION-BASED QUESTIONS

Select the cell B2 and click on the Format Painter in the Clipboard group on the HOME tab. Then click
and drag the mouse pointer over the cells C2:E2.
D4-10 E4-14

Filter
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ii. 1001, 1003, 1006
iii. Click the HOME tab. In the Editing group, click Sort & Filter and select Clear.

c. i. Conditional Formatting
ii. HOME tab, Styles group
iii. To clear conditional formatting, click Clear Rules in the Conditional Formatting drop down menu. A

submenu appears with two options: Clear Rules from Selected Cells and Clear Rules from Entire Sheet.
Select your preferred option.

d. i. Select StudentName column and on the HOME tab, in the Editing group click the Sort & Filter button.
The drop down list appears. Click Sort Largest to Smallest.

ii. Select Fees column and on the HOME tab, in the Editing group click the Sort & Filter button. In the
drop down list that appears, click Sort Smallest to Largest.

IN THE LAB
1. a. To perform the conditional formatting;: A i conie [emmtoes Name [ Departesentiie Projing
i. Select the cell range C2:E6. 4 Egé SEEE; E% E%
ii. Now onthe HOMEtab in the Styles group click the Conditional | —«c= Anpm = =
Formatting button and a drop down menu appears. - EETERTT 2 =

iii. From the menu select Highlight Cell Rules and from the
submenu select Greater Than.... A dialog box appears, enter 10 in the box and select the colour by

clicking Custom Format from the submenu. A dialog box appears. Under its Fill tab select dark red
colour.

iv. Click OK.
All the cells greater than 10 will be filled with dark red background.

b. To fill the cells lower than 8 with dark blue background, the steps will remain the same as above, but
replace step iii with the following:
From the menu select Highlight Cell Rules and from the submenu select Less Than.... A dialog box
appears, enter 8 in the box and select the colour by clicking Custom Format from the submenu. A dialog
box appears, under its Fill tab select dark blue colour.

All the cells less than 8 will be filled with dark blue background.

2. a. Select the DepartmentNo column and click the Sort and Filter / A E c B
button on the HOME tab in the Editing group. From the drop R e
3 K05 Sabika Al P2
down list select Sort A to Z. o T a1 P2
5 K03 njum A2 P3
b. Select the ProjectNo column and click the Sort and Filter button R = =
on the HOME tab in the Editing group. From the drop down e — —
liSt SeleCt Sort Z to A' 1 EmplnieeNﬂ Emplf:y:e Mame DepartrtlentNo ij:ctNa
c. Select the cell range A1:D8 and click the Sort and Filter button S e ceme Al P2
on the HOME tab in the Editing group. From the drop down s [ or[soms e o
list select Custom Sott.... In the dialog box that opens select B Ther e =
DepartmentNo in the Sort by field and A to Z in the Order e = =
field. Now click Add Level button to add another A B c D E
sorting criterion on the selection. Select ProjectNo , _ Helgntin _jweightin
K . R . StudentID| ~ |Student Name ~ |BirthDate ~ [Centimeters -T|Kilograms |~
in the Then by field and A to Z in the Order field. 5 apo2  |sameer 10-12-2001 160 60
3. On the HOME tab in the Editing group click the Sort 4 2234 Z:Ef Eiﬂfiﬂﬂf ifvz :Z
& Filter button and from the drop down menu select S APOS  Kiran 250220011 169 5
g APO3 Ghauri 21-10-2000 157 65
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Filters. Filter handles appear next to column headings. A B c D E
a. Click the handle next to Height in Centimeters and | ] Heigntin  |Weightin
. StudentlD| ~ |Student Name ~ |BirthDate ~ [Centimeters - |Kilograms |-T
from the drop down menu select Number Filters, from |2 ™ 2701 [sumayen 11-05-2001 151 55
the submenu select Greater Than.... Enter 155 in the |2 222 janum 02-01-2001 170 =
d' 1 b (i} APO5 Kiran 23-03-2001 165 59
ialog box.
b. Click the handle next to Weight in Kilograms and A B c D E
. Heigntin Weightin
from the dI'Op dOWn menu SeleCt Number Fl'ltersl 1 |StudentID| = |Student Name ~ | BirthDate|-T|Centimeters ~ |Kilograms |~
from the submenu select Less Than.... Enter 60inthe |z aco7  |vesur 18-10-2000 150 69
dialog bOX. g APOB Ghauri 21-10-2000 157 65
c. Click the handle next to BirthDate and from the drop - C i "
down menu select Text Filters, from the submenu Heignt in Wweight in
SeleCt Contains.... Enter 10 in the dlalog bOX. StudentlD| ~ |Student Name-T|BirthDate ~ [Centimeters - |Kilograms | -~
2 APOL Sumayyah 11-05-2001 151 55
s 4 4
d. Click the handle next to ‘Student Name’ and from |: | 2r02  |sameer 10-12-2001 160 50
the drop down menu select Text Filters, from the
submenu select Begins With.... Enter S in the dialog = a E
bOX 1 |First Name |Last Name |Username
: 2 |Shazia Khurram |Shazia.khurram@alsan.org
4. Enter Shazia.khurram@alsan.org in cell C2. In cell C3, |2 Roshanay |zafar Roshanay.zafar@alsan.org
start typing the First Name. As you do, the Flash Fill [4 Kamila  |Kabir Kamila kabir@alsan.org
logic suggests a series of values to fill in cells C3:C6. Press |2 Manan _ lVolna __ [Manan.volma@alsan.org
& |Javeria Sharmin  |Javeria.sharmin@alsan.org

ENTER to accept the suggestions.

GROUP PROJECT

Divide the class into an equal number of groups and ask each group to select a group leader. The group leader
can assign different tasks to the group members but ensure that all the students demonstrate adequate skills
while creating the Excel worksheet.

Chapter 4 Introducing Publisher 2013

OBJECTIVE TYPE QUESTIONS

1. a. iv.bothi. and iii. b. iv.bothi. and ii. c. i .pdf
d. ii. objects e. ii. Drop Cap

DESCRIPTIVE TYPE QUESTIONS

1. a. The Page navigation pane allows you to view and work with all the pages in your publication. You can
view the page thumbnails and add, delete, rearrange, and duplicate pages in this pane.

b. The two tabs that appear when you select a text box are: DRAWING TOOLS and TEXT BOX TOOLS
with their respective FORMAT tabs.

c. Typography refers to the style and appearance of the character in a piece of text. The typography
commands are found in the typography group on the FORMAT tab under TEXT BOX TOOLS.

d. Select the text box. Click the FORMAT tab under the DRAWING TOOLS tab on the ribbon. For changing
the colour of the text box, click the Shape Fill option, in the ShapeStyles group, and select the background
colour to fill the text box.
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e. Some fonts have decorative elements in their character set, mostly in the form of patterned serifs. The
Swash option enables these elements for the fonts.

Ligatures, on the other hand, are connections between characters that seem to create a single character
out of one or more characters. This makes the text appear more readable.

f.  Students should be able to explain the similarities and differences between the interfaces of MS Publisher
and MS Word. Below is a table which highlights some:

Similarities Differences

Both allow choosing font type, | MS Word is primarily used for text.
colour, and size.

Both allow formatting text MS Publisher allows extensive use of images.
such as the use of italics, bold,
underline, and justify.

Both allow for text alignment— | A blank document in MS Word is just a blank white space, while in
justify, left align, right align. MS Publisher it shows a blank white space with a blue boundary
and allows you to work only within that boundary.

Commands for formatting text | Rulers open automatically when opening an MS Publisher
are similar in both software. document. This isn’t the case in MS Word.

The left hand side of an MS Publisher document shows the pages
that the document contains, so you know how big your publication
is—this is not the case in MS Word.

To write text in MS Publisher, you have to draw a text box, while in
MS Word you can start typing right away.

g. Students should describe that MS Publisher is a software which has been developed to design various
types of documents using a desktop computer and offers many more options and more control in doing
so. A complete answer will include examples, such as the fact that MS Publisher has more options for
image manipulation. In MS Publisher, the user is able to move images and text around easily which
makes designing something like a greeting card easier. A student who opts for MS Word is not necessarily
wrong but the better software to use is MS Publisher.

h. The designs will vary from student to student. Once the students have designed the front page, the teacher
could ask each student to explain which tool they used and for what purpose. Their covers should show
creative manipulation of the text, which shows that they have chosen the font, and adjusted the size and
colour. Check whether they have used Drop caps, or the swash or ligature features.

APPLICATION-BASED QUESTIONS

a. i. Drop Cap

ii. To apply the Drop Cap feature, do the following;:
* Select the text.
* Click the FORMAT tab under the TEXT BOX TOOLS box.
¢ In the Typography group, click Drop Cap to view the various available styles.
¢ C(lick Custom Drop Cap option at the end of the list to get the Drop Cap dialog box. Change the
options in the dialog box that appears and click OK.

b. i. If a text box is not large enough to contain all of the text you want to include, you can use linking to
connect text boxes. The text will continue from one text box to the next.
ii. The steps to connect text boxes are:
1. Select the text box.
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2. Click the FORMAT tab under the TEXT BOX TOOLS tab and in the Linking group, click Create
Link.

3. The cursor changes to the link (a pitcher) icon. Click in the text box that you want to link.

4. The text boxes will be linked. Resize the linked box as necessary. Any text that overflows from the
original text box will now appear in the connected box.

pdf

To insert the name and telephone number in the card,

* Click the INSERT tab. Click the Business Information button in the Text group.

* Select Field Individual name. It is inserted in the publication.

* Drag the text box to the desired position. Widen the text box so that it can accommodate the telephone
number.

* Repeat the step but this time, select Field Phone/Fax/Email. It is inserted in the same text box.

Click the FILE tab and select Print option. The Print pane appears on the right with Print preview.

To print five copies, in Copies of print job box, type 5 and click Print button.

IN THE LAB
To make a banner like the one shown follow the steps given below:  gumumummnsmusmnsassnss s sRsuaaamms,
Choose a Scheme on the PAGE DESIGN tab. This will define the CONGRATULATIONS! WHIZ KIDS!
colour scheme of your borders, background, and other elements - &
of the banner. ) 7
Insert a bar from Borders & Accents on the INSERT tab in the / (5% ) - » 7 /Z )
D T )oKE

Building Blocks group. Duplicate it by clicking on it and pressing
Ctrl+C & Ctrl+V. Arrange it at the top & bottom edge of the page.
Select Draw Text Box on the INSERT tab in the Text group for ”'m':;‘t::lj':"”

the title, caption, and the school name.

To format the inputted text click the FORMAT tab under TEXT BOX TOOLS and in the Font group
change the font colour, size, and family.

Click Online Pictures on the INSERT tab in the Illustrations group. Search for relevant images on Office.
com Clip Art, select them, and click Insert.

To make an advertisement like the one shown in Publisher:

Choose an A4 landscape page.

Click Online Pictures in the Illustrations group on the Insert tab. Search for mobiles in Office.com Clip
Art. Select an image and click Insert. Resize the image to fit at the centre of the document.

To insert the background image and border click the Borders & Accents button in the Building Blocks
group on the INSERT tab. From the drop down menu that appears click More Borders and Accents...
and choose an image. Duplicate that image by selecting it and pressing Ctrl+C and Ctrl+V. Arrange
and resize it and move it to background by right-clicking on it and from the menu select Order -> Send
Backward.

To insert the advertisement offer image click the Advertisements button in the Building Blocks group
on the INSERT tab. From the drop down menu that appears click More Advertisements... and choose
an image. Arrange and resize it. Edit the text on the advertisements by double clicking the sample text
on it.

To insert the text click the Word Art button in the Text group on the INSERT tab. Add text in the dialog
box that opens and click OK. Arrange and resize it.

Click the Draw Text Box button in the Objects group on the HOME tab. Drag to draw it and add text.

Similarly, choose another item from the list and create another advertisement.
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3. Following are the steps to create the leaflet shown in Publisher:

a.
b.

10000644044

Choose an A4 landscape page.

On the INSERT tab in the Text group, click Draw Text Box for
the title, school name, date, and description. Add text to the
boxes.

A

r‘i
L/
=

7

1400446444000004044(9)

Springdale Public School
J 4000 0000004000000090:

On the HOME tab in the Font group apply font, font style, o ﬂmg‘@h " e B
colour, and size to the text in the boxes. 1 gim=-e / I % £
Position the text boxes as shown above. To make the school Al llll ¢_
name appear vertical, select it and click the FORMAT tab under E " % 3
DRAWING TOOLS and in the Arrange group select the Rotate  §4 = ¢ =sman (L) 4 4
option. Then select Best Fit in the Text group on the FORMAT  XAXXX XXX N A AT AN AT I

tab under TEXT BOX TOOLS.

To add pictures click the INSERT tab and in the Illustrations group select Online Pictures. In the dialog
box that appears, search in Office.com Clip Art. Add a confetti image to the background by inserting it
and selecting Apply to Background » Fill from the context menu.

To insert the border click the Borders & Accents button in the Building Blocks group on the INSERT
tab. From the drop down menu that appears click More Borders and Accents... and choose a border.
Duplicate it by selecting and pressing Ctrl+C and
Ctrl+V. Resize it and arrange it on the borders of
the page.

Springdale Public School

4. Pollowing are the steps to create the Class Pass shown

in Publisher: Clas S Pas S

a.
b.

Choose an A4 landscape page.

On the INSERT tab in the Text group, click Draw

Text Box. Draw text boxes for the title, school name, Class Teacher

class teacher name, signature, and description.

Add text to theboxes. & 7 ———— T ——————
On the HOME tab in the Font group apply font, Section ————— sign  _________
font style, colour, and size to the text in the
boxes.

Position the text boxes as shown above.

To insert the border click the Borders & Accents button in the Building Blocks group on the INSERT tab.
From the drop down menu that appears choose a border. Resize it and arrange it on the border of the

page.

Only two students allowed.

GROUP PROJECT

You might want to divide this exercise into two lessons—one where they work and second-where students
explain how they created their card. What you are looking for is a demonstration of the ability to utilise the
commands that have been used, as well as if they have been applied correctly. Ask each student what their
contribution was and how she/he went about accomplishing it; reward creativity generously, the idea should
be to encourage students.
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Chapter 5 Graphics in Publisher 2013

ii.

OBJECTIVE TYPE QUESTIONS
iii. PICTURE TOOLS b. iv. all of these c. ii. Arrange
iii. Wrap Text e. i. Picture Border

DESCRIPTIVE TYPE QUESTIONS

The different sources to insert pictures in your publication are:

* pictures stored on your computer.

¢ Office.com Clip Art, a series of royalty-free pre-defined graphics.
¢ Bing image search on the Internet.

The steps to swap pictures between a publication page and the scratch area are:

i. Inthescratch area, select the picture you want to swap with the picture in the publication. The selected
picture displays the swap icon.

ii. From the scratch area, drag the swap icon of the picture towards the picture on the publication.

iii. When the pink boundary is displayed, release the mouse button to swap the pictures.

Students should mention shapes, pictures, charts, and building blocks as the graphic options that
they can use in MS Publisher. Students also need to demonstrate their ability to utilise these tools. For
example, students should be able to explain that editing pictures, (cropping them to suit a particular
purpose; giving them a style; or setting them as a background), adds to the visual attractiveness of the
presentation. Students should be able to demonstrate how the Shapes tool allows for the insertion of
a variety of shapes which can then be coloured, made bigger or smaller to add value to the document.
In the same way, the use of charts gives options for representing numerical data in a pictorial fashion.
Students should demonstrate their knowledge about Building Blocks, that they are predefined objects
available in MS Publisher which allows the user to work with shapes, text, and images. Some templates
are available for making advertisements which makes it easier for design purposes.

This answer will depend on which book is being used for science. Give your students enough time to
look closely at their science text books and identify the different graphic features used to make the cover.
For example, the title will use font size, colour, and different types of font graphic features; the visual
feature might be put in a frame. You are looking for the students” ability to identify the different graphic
features used. Based on the students” answers, assess whether they have covered all aspects given in the
book.

Again you are looking for the students” ability to demonstrate their skills to use different tools. Look for
their creativity in what they have created and the difficulty level in terms of application of the tools that
have been learned.

APPLICATION-BASED QUESTIONS

Click Arrange Thumbnails button in Arrange group of FORMAT tab under PICTURE TOOLS.
CTRL + A
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i. Rotation handle

iii. Resizing handle
that resizes width

iv. Resizing handle
that resizes length

ii. Resizing handle that resizes
in both directions

c. Right-click the picture. The shortcut menu appears. Select Apply to Background and then Fill from the
submenu.

ii.

Click INSERT tab. Click Shapes button in Illustrations group. The menu appears. Select the shape. Drag

it on the publication.

Select FORMAT tab under DRAWING TOOLS. Click Shape Fill in Shapes Styles group and select red
colour. Click Shape Outline in Shapes Styles group and select blue colour. Bring the mouse to Weight
option, a submenu appears. Select More Lines. The Format Text Box dialog box appears. Change the

Width to 2 pt. Click OK.

IN THE LAB

1. Following are the steps to create the above poster in Publisher:

a.

b.

Choose an A4 portrait page.

On the INSERT tab in the Text group, click Draw Text Box. Draw
text boxes for the title, school name, and code of conduct points.

Add text to the boxes.

On the HOME tab in the Font group apply font, font style, colour,
and size to the text in the boxes.

Position the text boxes as shown above.

Click Online Pictures in the Illustrations group on the INSERT tab.
Search for frame in Office.com Clip Art. Select a frame and click
Insert. Resize the image to fit the borders of the document.

Similarly, search for checkbox in Office.com Clip Art. Select an
image and click Insert. Resize the image to fit at the beginning of
code of conduct points.

To insert a border at the end of the code of conduct points, click
the Borders & Accents button in the Building Blocks group on the
Insert tab. From the drop down menu that appears choose a border.
Resize it and arrange it at the bottom of the page.

2. Following are the steps to create the given poster in Publisher:

a.

Choose an A4 portrait page.
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Code of Conduct

Arrive to school ready to learn to the best
of ability.

Respect yourself, others, and all property.

Take responsibility for your behavior and
accept the consequences.

Support others by reacting appropriately
to bullying.

Be thankful and honest.

< KK

Resolve conflicts in a positive manner.




TEACHER’S RESOURCE

On the INSERT tab, in the Text group, click Draw Text Boxes. Now add a ;{ﬁgx L ;F“g%‘ﬁ,
text box. :

Add text to the box.

On the HOME tab in the Font group apply font, font style, colour, and size
to the text in the box.

Position the text box as shown.
To insert the border, click the Borders & Accents button in the Building Blocks [ Educate the Girl \
<

group On the INSERT tab. From the drop down menu that appears, choose
a border. Resize it and arrange it on the border of the page. Educate the Nation

Click Online Pictures in the Illustrations group on the INSERT tab. Search
for an appropriate image in Office.com Clip Art. Select it and click Insert. ﬁim’\tﬁ; wa 3
Resize the image.

To make the textbox like a parallelogram, click the text and on the FORMAT tab under DRAWING
TOOLS, in the Shape Styles group, click the Shape Effects button. From the drop down menu that appears

select 3-D Rotation -> Perspective -> Perspective Relaxed Moderately. Change colour of the box outline
using the same group.

Following are the steps to create the given poster in Publisher:

a.
b.

Choose an A4 portrait page.

On the INSERT tab, in the Text group, click Draw Text Boxes. Now add text boxes for the title, school
name, date, and description. Add text to the boxes.

On the HOME tab in the Font group apply font, font style, colour, and size to the text in the boxes.
Position the text boxes as shown above.

To add pictures, on the INSERT tab, in the Illustrations group select Online Pictures. In the dialog box
that appears, search in Office.com Clip Art. Add relevant images.

To change the background colour click the Background button in the Page Background group on the
PAGE DESIGN tab and choose the desired colour.

Following are the steps to make a 3-sided brochure in Publisher:

a0 oo

Trave] to Pakistan

Choose a Built-In template and choose Brochure. Select a sample brochure.
Edit the text in the text boxes of the front and back pages.
On the HOME tab, in the Font group apply font, font style, colour, and size to the text in the boxes.

To add pictures on the INSERT tab and in the Illustrations group select Online Pictures. In the dialog
box that appears, search in Office.com Clip Art. Delete the sample images on the template and add the
relevant images.
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GROUP PROJECT

Students should now be able to add the visual graphics, i.e. use the correct tools and be able to evaluate whether
the text and visual gel together. This means checking whether the text and visual images are too big or too small.
If there is writing on the visual, then has the student checked whether it is legible or not. Whilst making these
checks you will be able to gauge whether the students have been able to demonstrate their ability to use these
tools effectively.

Chapter 6 Basics of MS Small Basic

OBJECTIVE TYPE QUESTIONS
1. a. iii.” b. i.16 c. 1.6 d. ii.’ e. ii. ReadNumber ()

DESCRIPTIVE TYPE QUESTIONS

1. a. While working in Small Basic, you should remember the following points:

¢ All commands must be spelled correctly. For example, if you type WriteLn instead of WriteLine, an
error occurs. A command is also called a keyword.

* Akeyword is a reserved word, meaning it cannot be used as anything else, other than a command.
All computer languages have a specific set of keywords. Small Basic has 14 reserved words.

¢ Small Basic is not case-sensitive, meaning it does not differentiate between upper and lower case
letters. This means WriteLine and writeline are the same. But it is good practice to follow preferred
case rules in programming.

¢ Small Basic ignores all spaces; however spaces help to make the code readable.

b. The rules for naming variables are:

i. It should only include letters, numbers, and the underscore character.
ii. The first character must be a letter.
iii. It cannot be a reserved word of Small Basic.

c. The two types of variables are: Numeric and String. The Numeric type is further classified as Integer
and Floating.

d. Towrite a comment statement, an apostrophe (‘) is used before the text. For example, “This is a comment
statement

e. The Write( ) puts the pointer on the same line whereas WriteLine( ) moves the pointer to the next line.
The hierarchy is:
i. Parenthesis()
ii. Multiplication (*) and division (/)
iii. Addition (+) and subtraction(-)

g. The students should be able to explain that the purpose of writing programs is to evaluate the given
input and then perform an action based on the information received. The students should explain that

this means that a condition has to be set and when that condition is met some action or outcome should
occur. They should also be able to elaborate on the fact that:
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1ii.

TEACHER’S RESOURCE

* The simplest form of setting a condition in Small Basic is the: If-Then statement-which means if
something is true/false, i.e. the condition is met correctly, and then some other action should take
place.

¢ The If-Then-Else conditional statement not only allows for one condition to be met but also specifies
what needs to be done if the condition is not met.

¢ TheIf-Then-Elseif statement is useful when the user wants one action to be taken if a certain condition
is met, otherwise they can check if some other condition is met and therefore take a different action.
So it allows you to check and gives more flexibility.

i. The students should be able to differentiate between the values of S and A, using a comparison
operator.

ii. (10%4)+6
Here simple arithmetic operators are being used—multiply and addition.

iii. Students should be able to explain that a logical operator is being used because two conditions have
to be met before the program can proceed further.

This exercise is best divided into two parts. The first part will involve the students collecting data from
peers which can be completed in class. Once they have collected at least 10 pieces of information, they
can then move on to the next task which involves working in the lab. The program asks for two inputs—
the age of the student and if they bring lunch to school. The program could then list the names of just
those students under the age of 14. Of course the successful completion of this exercise depends upon
how much coding has been completed in the class.

APPLICATION-BASED QUESTIONS

The quotient of 10/3 is 3 and, the remainder is 1.
The quotient of 20/7 is 2 and, the remainder is 6.

This feature is called intellisense. It appears for inserting object names, properties, and methods in the
program.

To add a command in the program using this window, move through the list using the Up /Down arrow
keys and make a selection by pressing Enter.

C ii. a iii. d iv. b.

1, 2 ii. TextWindow

It moves the pointer to the next line. iv. Write( ) and WriteLine( )
IN THE LAB

TextWindow.Write (“Enter the radius of a circle”)
Radius = TextWindow.ReadNumber ( )

Area = Math.Pi() * Radius * Radius

Perimeter = 2 * Math.Pi() * Radius
TextWindow.WriteLine (“Area of a Circle = “ + Area)

TextWindow.WriteLine (“Perimeter of a Circle = “ + Perimeter)

TextWindow.Write (“Enter the Temperature in Fahrenheit”)
Fahrenheit = TextWindow.ReadNumber ( )

Celsius = Fahrenheit * 9/5 + 32

TextWindow.WritelLine (“Temperature in Celsius = “ + Celsius)
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P = TextWindow.ReadNumber ( )

TextWindow.Write (% Enter Principal amount “)

TextWindow.Write (Y Enter Rate of Interest “)

R = TextWindow.ReadNumber ( )

TextWindow.Write (% Enter Time in years %)

T = TextWindow.ReadNumber ( )
S=P*R*T /100

TextWindow.WriteLine (“Simple Interest = “ + S )

P = TextWindow.ReadNumber ( )

TextWindow.Write (Y Enter number of days a student is present “)

TextWindow.Write (% Enter total number of days in a month %)

M = TextWindow.ReadNumber ( )
Att Per = P/M * 100

TextWindow.WriteLine (“Percentage of Attendance of a student = “ + Att Per )

5. TextWindow.Write (“Enter Purchase Amount “)
PurAmount = TextWindow.ReadNumber ()
If (PurZmount >= 50000 And PurZmount <= 100000) Then

Discount = 0.01 * PurAmount

ElseIf (PurAmount >= 100001 And PurAmount <= 300000) Then

Discount = 0.015 * PurAmount

ElseIf (PurAmount >= 300001 And PurAmount <= 500000) Then

Discount = 0.02 * PurAmount
ElseIf (PurAmount > 500000) Then
Discount = 0.025 * PurAmount
EndIf
NetAmount = PurAmount - Discount

TextWindow.WritelLine (“Discount = “ + Discount)

TextWindow.WriteLine ("Net Amount

“ + NetAmount)

GROUP PROJECT

The design component of the answer in MS Publisher will draw from students’ previous learning. You should
assess whether they are using font and graphic tools appropriately. This can be assessed by the appropriateness
of the font being used for headings; e.g.its colour and formatting; whether a visual has been used properly and
set apart from text; and if mixed with text, whether the text is legible or not.

Similarities

Differences

Made by Microsoft

Small Basic creates Windows programs.

Evolution of the same language

QBasic cannot create Microsoft Windows programs.

Easy to learn syntax, which is very similar
from one form of Basic to the next

You can share your Small Basic programs with other users even
if they do not have Small Basic installed.

QBasic has to be installed in order to run QBasic programs.

VB is a Graphical User Interface (GUI) language.

VB is an object oriented programming language whereas
SmallBasic is not.
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Chapter 7 The Internet as a Post Office

OBJECTIVE TYPE QUESTIONS

ii. Uniform Resource Locator b. i. Surfing c. iv.all of these

ii. @ e. 1.in

DESCRIPTIVE TYPE QUESTIONS

i military ii network access provider iii Japan- country code for Japan

Number addressing system—In the number addressing system, the URL is a numeric address called
the Internet Protocol (IP) address. It is made up of four numbers in the range 0 to 255, joined together
by dots. For example, 192.12.148.77

Sent folder—It stores the messages that you have sent.
Draft folder—It stores messages that you started to write but have not yet sent.
The steps to create a signature for an email account are:

i. Click the Settings icon at the top-right corner of the Gmail window. From the drop down options,
select Settings.

ii. The Settings window appears. Scroll down to Signature section and type the text to be used as your
signature. You can also format the text using the buttons available for text formatting.

iii. Click Save Changes at the bottom of this page.

The Internet has definitely changed the way we communicate. Here are some ways that the Internet has
affected the way communication is carried out today:

e Earlier, when our parents were young there was no Internet or at least it wasn’t as developed as it
is today, and so most people relied on making telephone calls or writing letters on paper and then
posting them through the post office. Depending on where the letter was going, it could take months
for it to reach its final destination.

¢ The advancement in communications technology, especially the Internet, means that now
communication can be carried out in a matter of seconds. Whether we are using email, or using
applications such as Skype, Twitter, Instagram, or others like them, we are able to communicate
with people anywhere in the world instantantly.

¢ Landlines are hardly ever used anymore, as most smart phones have the ability to use the Internet
to communicate, so in many respects a smart mobile phone is no less than a computer.

* The use of the Internet has made it easier to communicate and means that we can share all important
news with each other in an instant. This has brought people closer, despite the distances.

Answers will vary. Students might realise that the Internet has become a repository of very large amounts
of data and in doing so it has generally become the first place that people turn to conduct research. Some
students might disagree with this notion, stating that if that was the case then no more books would be
published or that there would be no need for book libraries. Ask students if they are aware of the fact
that research can be carried out from a variety of sources amongst which the Internet is the quickest and
most comprehensive source.

Draft a detailed email to your principal requesting him/her to allow limited Internet access to students
in the secondary classes.

The answer should include a proper salutation such as Dear Sir or Dear Madam and the body of the
email should give reasons why students need to have access to the Internet at school. The reasons for
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allowing access could include: ease of doing research; keeping well informed of the latest happenings
in the world; exposure to new and different ideas which are applicable to all subjects; and the ability to
interact with other similarly aged students to get a world perspective on different issues. The student
could also mention in their email that they are requesting limited access, for example, during their weekly
library period, so that the school is able to offer safe monitoring to protect the students from misuse. The
email should end with a formal thank you note to the principal and have the students’ name.

APPLICATION-BASED QUESTIONS

a. Observe the figure and answer the questions
i. Email address - alsan.kb6.2013@gmail.com ii. Compose iii. Trash

b. i. Bcc
ii Tosend a picture as an attachment, click the Attach Files (paper clip) icon in the window. The Choose
File to Upload dialog box appears. Locate the file and click Open.
iii. Yes, he can format the text message. Click the Text Formatting icon to use formatting features like font,
font size, bold, italics, alignment, and indentation.

c. i. Emailis faster.
ii. Advantages of email:
* There is no charge for sending and receiving email messages.
¢ We need not be at our computer all the time to receive a message.

d. Itis important to close your account properly, especially when you are using a public or shared computer.
Signing out prevents misuse of your account by other people who will use the same computer.

IN THE LAB

1. The steps to send an email are:
a. Connect to the Internet.
b. Open Internet Explorer.

c. In the Address bar, type www.gmail.com or the URL of any other email service. The Web page will
appear in the browser.

Enter your email ID and password and click Sign In.
Click Compose to create a new message.
The New Message/Compose window appears.

Enter the email addresses of your friends in the To box.

S R

Write a subject for the message.

-

Type few sentences about the new features of Gmail.

j-  Click the Send button at the bottom to send the message.

2. The steps to send an email with a picture as an attachment are:
a. Connect to the Internet.
b. Open Internet Explorer.

c. In the Address bar, type www.gmail.com or the URL of any other email service. The Web page will
appear in the browser.
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Enter your email ID and password and click Sign In.

Click Compose to create a new message.

The New Message/Compose window appears.

Enter the email addresses of the five friends you wish to invite to your party in the To box.
Write a subject for the message.

Type the message.

To send the invitation card as an attachment, click the Attach Files (paper clip) icon in the window. The
Choose File to Upload dialog box appears. Locate the invitation card and click Open.

Click the Send button at the bottom to send the message.

The steps to send an email with a PowerPoint presentation as an attachment are:

Connect to the Internet.
Open Internet Explorer.

In the Address bar, type www.google.com or the URL of any other email service. The Web page will
appear in the browser.

Enter your email ID and password and click Sign In.

Click Compose to create a new message.

The New Message/Compose window appears.

Enter the email address of your computer science teacher in the To box.
Write a subject for the message.

Type the message.

To send the PowerPoint presentation as an attachment, click the Attach Files (paper clip) icon in the
window. The Choose File to Upload dialog box appears. Locate the PowerPoint file and click Open.

Click the Send button at the bottom to send the message.

The steps to send an email and the holiday homework file as an attachment are:

Connect to the Internet.
Open Internet Explorer.

In the Address bar, type www.google.com or the URL of any other email service. The Web page will
appear in the browser.

Enter your email ID and password and click Sign In.
Click Compose to create a new message.

The New Message/Compose window appears.
Enter the email address of your friend in To box.
Write a subject for the message.

Type the message.

To send the holiday homework file or files as an attachment, click the Attach Files (paper clip) icon in
the window. The Choose File to Upload dialog box appears. Locate the file or files and click Open.

Click the Send button at the bottom to send the message.
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GROUP PROJECT

Make sure that when you pair the students up you have mixed ability pairs; if your school is coeducational
make sure that groups have a healthy mix of boys and girls. This is an important factor in developing social
confidence. Answers should include following information:

Internet Protocol (IP) Domain Name System (DNS)

IP stands for Internet Protocol. It is a DNS stands for Domain Name System. It helps to

communications protocol, which is basically the ‘translate” human readable addresses to IP addresses;

backbone of the Internet. this has to be done because computers understand
IP addresses and not the fancy names given to the
websites.

Its development began in 1974, led by computer The information is stored on Domain Name Servers,

scientists Bob Kahn and Vint Cerf. which are something like electronic yellow pages.

There are five classes of IP addresses. It has been in use since 1985

IP address is like a mailing address and each By providing a distributed directory service, it is an

computer on the Internet has a unique IP address. essential component of the Internet.

It is frequently used in conjunction with the
Transmission Control Protocol, or TCP. Together they
are referred to as TCP/IP.

IP delivers packets from the host to the destination
using the ‘addresses’ found in the headers of data
packets.

All information transferred on IP is in ‘packet” form.

IPv4 the dominant version is being used on the
Internet.

Chapter 8 Introduction to Flash CS3

OBJECTIVE TYPE QUESTIONS
1. a. i.ZoomIn b. ii. 12 c. ii. File
d. i. Property Inspector e. iv.all of these
DESCRIPTIVE TYPE QUESTIONS

1. a. The grid is a system of intersecting horizontal and vertical lines on the stage. The grid is helpful while
creating graphics. It helps you to place and align objects at particular positions on the stage.
b. The steps to save a file in Flash CS3 are:
i. Select Save As option of File menu. The Save As dialog box appears.
ii. Select the drive and folder where you want to save your file.
iii. Type the filename in the Filename box.
iv. Click the save button. The file is saved with .fla extension.
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iv.

ii.

iii.

ii.

TEACHER’S RESOURCE

The steps to open an already saved file in Flash are:

i. Select Open option from the File menu. The Open dialog box appears.
ii. Select the drive and the folder.

iii. Select the file.

iv. Click Open button.

Names of games could include: “Angry Birds’, ‘Clash of Clans’, ‘FarmVille’, “AdventureQuest’,
‘Machinarium’, ‘Hundreds’, 'N’, “'QWOP’ and ‘Solipskie’r; these are some of the more popular games
developed using Flash CS 3. Answers for the questions about similarities and differences will vary, in
terms of what the games are about, and what the purpose of the games are. For example, in ‘Angry
Birds’ the players try to save eggs, while in ‘Hundreds’ players have to touch circles ensuring that they
don’t overlap, and "‘Machinarium’ is an adventure game. Similarities between the games could include
the use of multiple animations, differing shapes and a wide spectrum of colours.

a. Similarities Differences

It allows you to work with different types of graphics | MS Publisher tools are more Text

in terms of inserting shapes into the document, filling [ friendly being closer in the way they
them with colours, magnifying them, adding text to operate to MS Word rather than Flash
them. CS 3.

The reason for using different software is because the focus of Flash CS 3 is on creating and manipulating
different shapes, while MS Publisher allows for considerable text manipulation along with the use of
graphics.

Here you are looking for the students’ ability to use the appropriate command to open a new document:
Select->File->New Document. They then need to assign properties to their document using the Modify ->
Document Properties. Next they have to use either the Merge Drawing Mode or Object Drawing Mode
to create the shapes required. Marks can be given based on student creativity.

APPLICATION-BASED QUESTIONS

Some tools have a small triangle at the bottom right corner. On clicking it, a pop-up menu appears with
more related tools.

Pen Tool

Modify menu and Document option
Dimensions of the Stage 550 px by 400 px
Frame rate selected for the movie is 12

The ruler unit selected for the movie is pixels. The default ruler unit is pixels.

The two options of the Magnifier Tool—Zoom In allows you to view the drawing up close, while Zoom
Out pulls you away from the drawing by showing it at lower magnification.

Stroke color—Black and Fill color—Blue

Lasso Tool is used to select irregular areas on the Stage.

Merge Drawing mode was selected.

He should have selected Object Drawing mode.
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IN THE LAB
1. To start Flash, click Start» All Programs » Adobe Premium Design CS3 » Adobe Flash CS3 Professional.

a. Familiarise yourself with the Tools panel, Timeline, Stage, and Property inspector.
2. The steps to create a new document are:
i. Select New from the File menu. The New Document dialog box appears.
ii. Select Flash File (ActionScript 3.0) in the Type list and click OK.
a. To change the background colour to yellow, select Modify » Document.
b. To Show or Hide rulers, click View » Rulers.
c. To change the ruler units, select Modify » Document.
d. To Show or hide grid, Click View » Grid » Show Grid.
3. a. The steps to open an image in Flash are:
i. Select Open from the File menu. The Open dialog box appears.
ii. Select the drive and the folder.
iii. Select the file.
iv. Click Open button.
b. To select different parts of image using the Lasso Tool:
i. Select the Lasso Tool.
ii. Drag the cursor on the stage to specify the boundary of the selection.
iii. End the selection approximately near the point where you started.
4. a. The steps to create a new document are:
i. Select New from the File menu. The New Document dialog box appears.
ii. Select Flash File (ActionScript 3.0) in the Type list and click the OK button.
b. Draw a circle and then draw an overlapping rectangle.
i. Try to move the rectangle to another position.

If the portion of the circle gets erased, then Merge Drawing mode is selected otherwise Object Drawing
mode is selected.

GROUP PROJECT

Presentations will of course vary. You can decide to divide the number of marks you give based on presentation.
This can include the overall look and content of what students have put together as well as the use of fonts and
formatting. Good presentations, for example, could include an explanation of how each student went about
making their Flash document. Content could also include some historical information about Flash; how it was
developed and what the future might be like.

Chapter 9 Drawing Tools in Flash CS3

OBJECTIVE TYPE QUESTIONS
1. a. iv.all of these b. iii. bothi. and ii. c. 1i.Oval
d. ii. circular e. ii. Shift
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DESCRIPTIVE TYPE QUESTIONS

1. a. Two modifiers of the Eraser Tool are Faucet Modifier and Eraser Mode Modifier.
When you draw a rectangle with rounded corners, you first have to specify the radius for the corners
and then draw the shape. After drawing the shape, you cannot modify the radius if you used Rectangle
Tool. Butif you used Primitive Rectangle Tool, then you can modify the radius after drawing the shape.
c. The steps to create a new gradient are:

i. Select Window » Color.

ii. Click the drop down arrow of the Type box and select a gradient style—Linear or Radial.

iii. Click the colour markers you want to change. The colour palette appears.

iv. Select a colour. You can also click and shift the colour marker left or right on the gradient bar to

adjust the gradient.

v. To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off
the bar.

vi. You can continue creating the gradient effect by adding colour markers and assigning colours to
them.

d. Students have an opportunity here to either agree or disagree with this statement. In either case the
student will need to justify their answer.

For those who say NO: they may argue that regardless of what software is able to do: -

¢ the originality that an artist brings using a traditional palette cannot be replaced.

¢ the human element of understanding the colours and tones required and the ability to produce them
cannot be imitated.

* acomputer is pre-programmed and has limitations.

For those who say YES: These students may argue: -

* the software has the ability to not only match but to do much more than an artist with a traditional
palette.

* thesoftware gives an artist more flexibility through a number of options for manipulating the canvas
in terms of shape, size, colour, and so much more.

¢ rather than wasting sheets of paper because something goes wrong, the software allows for multiple
corrections to be made on screen.

* using software provides more time for the artist to be truly creative.

e. Here you are assessing the students’ ability to comprehend why the property inspector is used. Answers
could include points such as:

* To assign different “properties’ to the shapes inserted into a flash document.
* Properties such as colour fill, stroke (thin or thick borders), allow users to change shapes as they

require.
* Itis extremely important because without it all documents created in Flash would look very similar
indeed!
APPLICATION-BASED QUESTIONS
a. i. Pencil Tool ii. Straighten modifier
iii. Smooth modifier iv. Ink modifier

b. To create a cartoon character Dania can use the following tools:

i. Paint freely—Pencil Tool ii. Rectangle Tool iii. Paint Bucket Tool
c. i. Colour panel ii. Linear gradient
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d. Eraser modifiers she will use are:

i. Erase lines ii. Erase Normal iii. Erase fills

e. Here you are assessing the student’s ability to use the commands learned so far and to apply them in making
an image. You can also give marks for creativity; you could ask students questions about how they applied
a certain colour, or how they cut the shape in a particular way.

IN THE LAB

1. a. To draw lines using the Pencil Tool:

L.
ii.

iii.
iv.

V.

Vi.

Select the Pencil tool.

In the Property inspector, select stroke colour, line thickness, and style.

When this tool is selected, its modifier is displayed in the lower area of the Tools panel.
Clicking on the modifier icon shows three options—Straighten, Smooth, and Ink.

In this case select Smooth modifier.

Click and drag to draw the lines.

b. To create a new gradient:

1.
ii.

1ii.
iv.

Vi.

Select Window » Color. The Colour panel appears.

Click the drop down arrow of the Type box and select a gradient style. You can select Linear or
Radjial gradient.

Click the colour markers you want to change. The colour palette appears.

Select a colour. You can also click and shift the colour marker left or right on the gradient bar to
adjust the gradient.

To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off
the bar.

You can continue creating the gradient effect by adding colour markers and assigning colours to
them.

c. Tofill colour with the Paint Bucket Tool:

1.
ii.

iii.

iv.

Select the Paint Bucket Tool.

Select the fill colour from the Property Inspector.

Click the drop down arrow of Gap Size modifier and choose a gap size option to close gap in the
shape.

Click inside the shape for filling it with colour.

2. a. Todraw lines using the Pencil Tool:

i.
ii.

1ii.
iv.

V.

Vi.

Select the Pencil Tool.

In the Property inspector, select stroke colour, line thickness, and style.

When this tool is selected, its modifier is displayed in the lower area of the Tools panel.
Clicking on the modifier icon shows three options—Straighten, Smooth, and Ink.

In this case select the Smooth modifier.

Click and drag to draw the lines.

b. To draw the flower shape:

1.
ii.

iii.

iv.
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Draw a star shape.

Click the Arrow Tool.

Make sure that no line is selected. Bring the mouse pointer near a line. A curve appears below the
mouse pointer.

Click and drag to reshape the line and then release the mouse button. Do this for all other lines of
the star shape
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To create a new gradient:

i
ii.

1ii.
iv.

Vi.

Select Window » Color. The Colour panel appears.

Click the drop down menu arrow of the Type box and select a gradient style. You can select Linear
or Radial gradient.

Click the colour markers you want to change. The colour palette appears.

Select a colour. You can also click and shift the colour marker left or right on the gradient bar to
adjust the gradient.

To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off
the bar.

You can continue creating the gradient effect by adding colour markers and assigning colours to
them.

To fill colour with the Paint Bucket Tool:

1.
ii.

iii.

iv.

Select the Paint Bucket Tool.

Select the fill colour from the Property Inspector.

Click the drop down menu arrow of Gap Size modifier and choose a gap size option to close gap in
the shape.

Click inside the shape for filling it with colour.

To draw lines using the Pencil Tool:

1.
ii.

1ii.
iv.

V.

Vi.

Select the Pencil Tool.

In the Property inspector, select stroke colour, line thickness, and style.

When this tool is selected, its modifier is displayed in the lower area of the Tools panel.
Clicking on the modifier icon shows three options—Straighten, Smooth, and Ink.

In this case select the Smooth modifier.

Click and drag to draw the lines.

To create a new gradient:

i.

ii.

ii.

iv.

Vi.

Select Window » Color. The Colour panel appears.

Click the drop down menu arrow of the Type box and select a gradient style. You can select the
Linear or Radial gradient.

Click the colour markers you want to change. The colour palette appears.

Select a colour. You can also click and shift the colour marker left or right on the gradient bar to
adjust the gradient.

To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off
the bar.

You can continue creating the gradient effect by adding colour markers and assigning colours to
them.

To paint inside the balloons using the Brush Tool

i

ii.

iii.

iv.

Select the Brush Tool.
Select the fill color.

Click the Brush Mode Modifier from the Tools panel and select a painting mode. You can also select
the desired brush shape and size.

Drag the mouse pointer on the stage to apply a brush stroke.

To fill colour with the Paint Bucket Tool:

i

ii.

Select the Paint Bucket Tool.
Select the fill colour from the Property Inspector.
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iii. Click the drop down menu arrow of the Gap Size modifier and choose a gap size option to close gap
in the shape.

iv. Click inside the shape for filling it with colour.

e. To paint colour behind the balloons:
i. Click the Brush Tool.
ii. Select the fill color.
iii. Click the Brush Mode Modifier and select the option Paint Behind.

f.  To write text using the Brush Tool:
i. Select the Brush Tool.
ii. Select the fill/gradient color.
iii. Select the desired brush shape and size.
iv. Drag the mouse pointer on the stage to apply a brush stroke.

4. a. Todraw lines using the Pencil Tool:

i. Select the Pencil Tool.
ii. Inthe Property Inspector, select stroke color, line thickness, and style.
iii. When this tool is selected, its modifier is displayed in the lower area of the Tools panel.
iv. Clicking on the modifier icon shows three options—Straighten, Smooth, and Ink.
v. In this case select the Smooth modifier.
vi. Click and drag to draw the lines.

b. To fill colour with the Paint Bucket Tool:
i. Select the Paint Bucket Tool.
ii. Select the fill colour from the Property Inspector.

iii. Click the drop down menu arrow of Gap Size modifier and choose a gap size option to close gap in
the shape.

iv. Click inside the shape for filling it with colour.
c. To write text using the Brush Tool:

i. Select the Brush Tool.

ii. Select the fill/gradient color.

iii. Select the desired brush shape and size.

iv. Drag the mouse pointer on the stage to apply a brush stroke. Type a greeting like “Happy
Independence Day”.

GROUP PROJECT

Open FL and HTML 5 could be given as examples by students. Open FL is very similar to Flash, while there is
a tool which converts Flash into HTML to be used on web browsers. Advertisements will differ but what you
are assessing is how well the students have used the commands that they have learned. Creativity should be
appreciated. Generally the marking scheme could focus on: presentation of work, research skills, content, and
creativity.
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Chapter 10 Creating Animations in Flash CS3

ii.

1.

1i.

iii.

ii.

iii.

OBJECTIVE TYPE QUESTIONS

i. motion b. ii. small c. iii. Library d. i.symbol

DESCRIPTIVE TYPE QUESTIONS

The black dots in the Timeline indicate a keyframe.
The keyboard shortcut to insert a frame is F5 and keyframe is F6.
The steps to delete frames 5 to 10 are:

i. Select the frames 5 to 10.
ii. Right-click and select Remove Frames from the shortcut menu.

We can convert the Robot shape to a man using Shape tweening.
Important points to create motion tween:

i. Drawing must be converted into symbol.
ii. Specify the initial and the final positions.

TEACHER’S RESOURCE

e.

ii. Timeline

Regardless of whether the student says yes or no on how user friendly the software is, they should be
able to justify their choice by giving logical explanations for it. For example, if they say it is not user
friendly, they could say that the tool bar is too confusing to use with strange symbols and names such

as the lasso tool. Others could disagree and say that it is as easy to use as any other software.

You will be evaluating students on their understanding and usage of the commands that they have
learned so far in the textbook. The more commands they use correctly is indicative of the fact that they
have the developed the skills needed to do so, but it is also helpful to test student knowledge by asking
a few oral questions based on what they have created. Give marks for creativity and be generous so that
it encourages students to gain confidence and experiment more with using the software.

APPLICATION-BASED QUESTIONS

A Timeline is shown in the given figure.
Frame 1 is the keyframe.
The frame rate is 12 fps.

Shape tweening.
Elapsed time—4.0 s
Current frame—21s

The keyboard shortcut to get the Convert to Symbol dialog box is F8.

Graphic
Modify menu

Shape tweening  ii. No iii. Green colour

IN THE LAB

Draw a scenery using different tools.

To convert an existing drawing into a symbol:
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i. Select the Arrow Tool.
ii. Select the drawing on the stage.
iii. Select Modify » Convert to Symbol. The Convert to Symbol dialog box appears.

1. Type a name for the symbol.
2. Choose Graphic as the Type of Symbol.
3. Click OK. The symbol gets added to the Library panel.

c. Toinsert an instance of the symbol:

i. Select Window » Library to open the Library panel. You will see the symbol you created.
ii. Click and drag it onto the Stage. This inserts one instance of the symbol.

d. Draw a bird and a tree using different tools. Convert the bird object into a symbol using the above
process.

e. Copy the tree object and paste it in the right side of the Stage.
f. To apply motion tweening to a symbol:

i. Select frame 40. Select the bird and move it to the top of the tree on the right side of the Stage.

ii. Select any frame between 1 and 40. With the cursor in the grey area, right-click and select Create
Motion Tween from the context menu.

iii. Notice the change in the Timeline window. A light-purple colour with a solid arrow appears between
the frames.

iv. Play the movie. You will see the bird move from the tree at the left corner to the right tree at the right
corner of the Stage.

2. a. Draw or import a picture of a boat at the top-left corner of the stage in frame 1.
b. Convert the shape into a symbol. Give the symbol the name boat.

Select frame 40 in the Timeline window and insert a keyframe by pressing F6 or selecting Insert» Timeline
» Keyframe.

d. Notice that all the frames from 2 to 39 are now in grey colour. Frame 40 has a grey fill with a black dot,
indicating that it is a keyframe.

e. Select frame 40. Select the boat and move it to the top-right corner of the Stage.

f.  Select any frame between 1 and 40. With the cursor in the grey area, right-click and select Create Motion
Tween from the context menu.

g. Notice the change in the Timeline window. A light-purple colour with a solid arrow appears between
the frames.

h. Play the movie. You will see the boat move from the top-left corner to the top-right corner of the Stage.

3. a. Select the first frame in the Timeline.
b. Select the Oval Tool. Then select the stroke colour and fill colour.
c. Draw a Circle shape on the Stage.
d. Select frame 20 in the Timeline and insert a Blank Keyframe by pressing F7 or by selecting Insert »
Timeline » Blank Keyframe.
e. Draw a Cat shape on the stage. You can also change the stroke color and fill color.

f. Click on any frame between 1 and 20 in the Timeline. Right-click and select the Create Shape Tween
option from the context menu.

g. Select Frame 1 in the Timeline and press Enter to play the movie.
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4. a. Draw a star shape on the stage.
b. Click on the second frame in the Timeline window.
c. Insert a keyframe by selecting Insert » Timeline » Keyframe or by pressing F6.
d. Draw another star on the stage.

Add ten more keyframes and draw a star shape at different positions in each frame. You can change the
colour of the star in each frame.

f. To play the movie, Click on the first frame in the Timeline window. Then Select
Control » Play.

GROUP PROJECT

Make sure that the groups you make have mixed ability of students with a range of abilities. Ask the students
to select a group leader who will assign individual tasks and make sure that the work is completed on time.

There is a long list of animated characters, TV series, and movies that were made using Flash, so the answers
here will vary. Some names that you could come across include: “The Simpsons’, “The Adventures of Rocky and
Bulwinkle’, “Danger Mouse’, and ‘Speed Racer: the Next Generation'.

In terms of the video that the students create you are looking for creativity as well as the skills to use appropriate
commands.

ASSESSMENT 1

SECTION A (THEORY)

1. Who amI?
a. E-book reader b. Smart phone c¢. MICR Characters d. Alignment

2. Identify what the following figures represent.
a. LCD Projector b. Flatbed plotter c. OMR Sheet d. Barcode

3. Answer the following.

a. Hardware—The physical components of a computer that we can see and touch are called hardware.
Examples —Keyboard, Mouse.
b. MICR—Magnetic Ink Character Recognition

OCR—Optical Character Reader

4. Observe the given worksheet and answer the following questions.
a. Left
b. Bold, Fill Color
c. Home tab, Font group
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SECTION B (PRACTICAL)
The steps to create the worksheet in Excel 2013 are:
1. Type the data as shown in the worksheet.
2. Click the HOME tab.
3. Select A1:Cl.

¢ In the Alignment group, click Merge & Centre button.
¢ In the Font group, click Bold, change Font to Times New Roman, and change Font Size to 14.

4. Select A1:C2.

* In the Font group, click the Fill Color button and select green. Click the Text color drop down menu
arrow and select blue.

5. Select cells A2:C2 and A3:A7. Click the Centre button in the Alignment group.
6. Select cells C3:C7. Click Accounting Number Format in the Number group and select Symbol as English.
7. Select cells A2:C7. Click the Border button in the Font group and select All Borders.

ASSESSMENT 2
SECTION A (THEORY)
1. a. Fillhandle b. Sort c. Filter d. Conditional formatting e. Flash Fill
f.  Objects g. Template h. Guides i. .pub j. Addlevel

2. Features used in the publication given alongside are Drop Cap and Text Direction.

3. The three sources from where you can insert a picture in your publication are:
e from your computer

e from the Office Clip Art collection
e from the Internet

4. The rearranged steps are:

a. In the scratch area, click the picture you want to swap with the picture in your publication.

b. The selected picture shows the swap icon.

c. From the scratch area, drag the swap icon of the picture towards the picture on your publication.
d. When the pink boundary is displayed, release the mouse button to swap the pictures.

5. a. Scratch area
. Ctrl+ A
c. Click the Arrange Thumbnails button in the Arrange group on the FORMAT tab under PICTURE
TOOLS.
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SECTION B (PRACTICAL)

1. Enter the data in a worksheet in cells A1:C11.
a. To sort the data in ascending order of EmployeeSalary, do the following;:

i.

ii.

1.

Select a cell in the column according to which you want to sort the data. Here, select a cell in the
column C, say C2.

Click the HOME tab. In the Editing group, click the Sort & Filter button. The drop down list appears.
Click Sort Smallest to Largest to sort in ascending order.

b. To format all the rows having salary greater than 50000 with red background, do the following:

1.
ii.

iii.
iv.

Vi.

Select the range A1:C11 in the worksheet.

Click New Rule in the Conditional Formatting drop down menu. The New Formatting Rule dialog
box appears.

Under the Select a Rule Type box, click Use a formula to determine which cells to format.

Under Format values where this formula is true, type ‘=" and then click a cell in the EmployeeSalary
column of the worksheet, say C2. You will see the value ‘=$C$2" appear in the text box. Delete the
dollar sign before the row number and type “>50000". So now you have the value ‘=$C2 > 50000" in
the box.

Click Format. The Format Cells dialog box appears. Click the Fill tab. Choose red as the background
colour and click OK.

You will see the New Formatting Rule dialog box again. Click OK. The rows with EmployeeSalary
greater than 50000 now have red colour.

c. To filter all the records having salary in the range 30000 to 50000, do the following:

1.
ii.

iii.
iv.

Vi.

Select a cell in the range A1:C11, say B2.

Click the HOME tab. In the Editing group, click Sort & Filter and select Filter from the drop down
list.

Drop down arrows will appear next to each column heading.

Click the drop down arrow in the EmployeeSalary column, a menu appears. Click Number Filters.
A submenu appears. Select the Between option.

A Custom AutoFilter dialog box appears. Enter 30000 in the first text box and 50000 in the second
text box and click OK.

The filtered rows that satisfied the condition will be displayed in the worksheet.

2. Todesign an Entry Pass as shown, do the following:

a. Click the New option of the File menu.

b. Click the More Blank Pages Sizes option. A list of blank page
size appears.

c. Click Create New page size. The Create New Page Size . .
dialog box appears. 5pr|ngda|e Public SCh00| FetE

d. Set the Page Width to 10 cm and Height to 10 cm and click
OK.

e. A customised page will appear on the screen.

i

To type the heading—Springdale Public School Fete, [ pates 15 septemver 201 Time: 0 Am o6 Pm |
do the f0110W1ng | Note: Only one person is allowed on one pass. |
i. Click the INSERT tab.

ii. Click the WordArt button in the Text group. Sig. of Principal Sig. of Manager

iii.

The WordArt styles gallery will appear. Select the style.
The Edit WordArt Text dialog box opens. Enter the text.
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Change the Size and click OK.
iv. Place the text at a suitable place.

To insert the picture, do the following:

i. Click the INSERT tab.

ii. Click the Online Pictures option in the Illustrations group. An Insert Pictures dialog box appears.
Enter the search name in the Office.com Clip Art text box. A list of pictures will appear. Select the
picture and click Insert.

iii. Place the picture on the entry pass.

To insert the Date, Time and Note, do the following:

i. Click the INSERT tab.

ii. Click Draw Text Box in the Text group.

iii. Draw the text box on the publication.

iv. Type the text.

v. Click the FORMAT tab under DRAWING TOOLS.

vi. Click the Shapes Fill button in the Shapes Styles group and select the colour.

vii. Click the Shape Outline button in the Shapes Styles group and select the border colour and weight.

To insert the signature of the Principal and the Manager, do the following:

i. Draw text boxes on the publication.

ii. Type the text. Make it bold.

iii. To draw a line, click Shapes in the Illustrations group on the INSERT tab.

iv. Click the line tool and drag it on the publication.

v. Change the thickness, as required.

For the boundary of blue colour, do the following;:

i. Draw the text box on the publication.

ii. Click the FORMAT tab under Drawing Tools.

iii. Click Shape Outline in the Shapes Styles group and select the desired border
and weight.

COMPREHENSIVE ASSESSMENT |

1. Answer the following in a few words.

a. Windows, Android b. Font c. Brochure, Certificate
d. Margin, Customisable e. Create Link f.  Wrap Text

g. Ctrl h. Borders & Accents, Advertisements

j-  Microcomputers

2. Answer the following.

a.

Compiler—
i. A compiler first reads the whole program and then at one go translates it into machine language.
ii. The object program is saved permanently for future use.

Interpreter—

i. An interpreter is a program that translates one statement of a high-level language program into
machine code and executes it. It then does the same for the next statement.

ii. The object code produced by an interpreter is not saved.
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b. Utility Software—A utility is a program designed to do maintenance work on the system or on system
components. Example, Antivirus software—McAfee; Backup Software.

c. A3-10,A4-13,A5—16

d. Custom filtering is to filter the data based on a specified condition. Two options of custom filtering are
Less Than and Greater Than.

e. Click Clear Rules in the Conditional Formatting drop down menu. A submenu appears, select Clear
Rules from Entire Sheet.

Fill in the blanks
a. hardware b. barcode c. banks d. Optical Mark Reader e. plotter

Write T for the true statement and F for the false one. Correct the false statement(s).
a. T

b. T

c. F. You can sort/filter data according to cell colour.

d. F. You can sort data on two fields.

e. F. Filtering means to display the data that satisfies a condition.

The ten formatting features applied to the data are:

a. Font b. Font Size c. Bold d. Fill Color
e. Font Color f.  Wrap Text g. Merge & Centre h. Border
i. Middle Align j-  Accounting Number format

Choose the correct option.

a. iv.Java b. ii. Best Fit c. ii. Drop Cap
d. i. Four-sided e. ii. Extends a sequential range of data f.  iii. Flash Fill
g. iii. File » Options » Advanced h. i.Home i. ii. Reapply
j- . Top 10
ASSESSMENT 3

SECTION A (THEORY)

a. 1. Uniform Resource Locator
ii. World Wide Web
iii. Blind Carbon Copy

b. The two types of addressing systems are:
Letter addressing system, e.g., pakistan.gov.pk
Number addressing system, e.g., 192.12.148.73

Match the following.

a. 1ii. b. iv. c. i d. wv. e. 1
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3. Answer the following in one word.

a. Search Engine b. Trash c. Contacts

4. Give the full form of the following.

a. Modulator Demodulator b. Internet Service Provider

SECTION B (PRACTICAL)

The program code in Small Basic:

"This program inputs the height of the three friends in centimetres
TextWindow.Write{("Enter height of first friend ")
a = TextWindow.ReadNumber({ )}
TextWindow.Write("Enter height of second friend ")
b = TextWindow.ReadNumber({ )}
TextWindow.Write("Enter height of third friend ")
¢ = TextWindow.ReadNumber({ )}
'Compare the height of fwo friends and store the greatest in a variable [
If (a > b) Then
l1-=a
Else
l1=0
EndIf
'‘Compare the height of the third friend with variable [
If (c > 1) Then
l1=c
EndIf
'Display the value of variable |

W88 =~ T WA B L g e

e e e el e e e =
Woed =l o L1 W R @

TextWindow.WriteLine ("The height of the tallest friend is " + 1 +

- ™y

¢ To save the program, click the Save button. The Save As dialog box appears. Enter the program name as

Largest and click Save.

¢ To print the program, copy and paste the program in any word processor software, say, Word 2013 and

click the Print option of the File menu. The Print dialog box appears. Click OK.

ASSESSMENT 4

SECTION A (THEORY)

1. STRAIGHTEN, SMOOTH, INK

2. Define the following.

a. Symbol—A symbol is a graphic image, animation, or button that is stored along with a movie.

b. Instance—Instance is an occurrence of a symbol.

c. Frame Rate—Frame rate shows the number of frames per second that your animation will play.
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Answer the following in one word.

a. Stroke b. Arrow (Selection) tool ¢. Oval tool d. Tools panel e. Timeline

Observe the following figure and answer the given questions.
a. 1. Tools panel ii. Timeline iii. Property Inspector
b. Stage. It is the place where graphics, text, and video clips are placed and the movie is created.

¢. Modify menu and Document option

SECTION B (PRACTICAL)

Start Flash CS3 and create a new file. To create the given animation do the following:
a. Select the first frame in the Timeline.

b. Select the Oval Tool. Then select the stroke colour and fill colour.

c. Draw a circle on the Stage.
d

Select frame 20 in the Timeline and insert a Blank Keyframe by pressing F7 or by selecting Insert »
Timeline » Blank Keyframe.

o

Draw a star on the stage. Change the stroke colour and fill colour.

f. Click on any frame between 1 and 20 in the Timeline. Right-click and select the Create Shape Tween
option from the context menu.

g. Select Frame 1 in the Timeline and press Enter to play the movie.

COMPREHENSIVE ASSESSMENT I

Fill in the blanks.
a. ReadNumber()
b. 2

c. Library

Write T for the true statement and F for the false one. Correct the false statement(s).

a. T
b. F. The arithmetic *’ can be used in Small Basic.
c. T

Answer the following in one or two words

a. Program b. Numeric and String

c.  Write() and WriteLine( ) d. Conditional

e. .sb f. Default mode in Flash—Merge Drawing mode
g. Lasso Tool h. Property Inspector

Answer the following

a. The three letters of the domain name are important because they provide information about the kind of
organisation to which the address belongs.
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b. Itis important to sign out of your email account properly, especially when you are using a public or
shared computer. This will prevent misuse of your account by other people who will use this computer.

c. Advantages of email are:

i. Email is much quicker than normal post.
ii. We need not be at our computer all the time to receive a message.

5. 1 TextWindow.Write(“"Enter the first number™)
2 a = TextWindow.ReadNumber()
3 TextWindow.Write("Enter the second number™)
4 b= TextWindow.ReadNumber()
5 If a < b Then
6 l=a
7 Else
8 l1="0b
9 EndIf
18 TextWindow.WritelLine("The smallest number is " + 1)
1 TextWindow.Write("Enter the side of a Square")
2 side = TextWindow.ReadNumber( )
3 area = side * side
4 perimeter = 4 * side
5 TextWindow.WritelLine("Area of a Square = " + area)
6 TextWindow.WritelLine("Perimeter of a Square = " + perimeter)
7. 120,000 ii 3750

The value of the discount will be printed from the next line
The line TextWindow.WriteLine(“Discount = “ + discount) uses the property of concatenation.
This program calculates and displays the discount

e

8. Choose the correct option.

a. iv. Print b. iii. 255 c. ii. Inbox

d. iv.all of these e. i Property Inspector f.  ii. Primitive Rectangle Tool
g. i.Rectangle Tool h. ii. F6 i iii. fla
CYBER OLYMPIAD QUESTIONS

1. ¢ 11. d 21. a 31. d
2. d 12. a 22. a 32. d
3. d 13. a 23. a 33. b
4. a 14. c 24. b 34. b
5. d 15. a 25.d 35. a
6. d 16. c 26. ¢ 36. ¢
7. a 17. a 27. ¢ 37.d
8 b 18. d 28. d 38. b
9. b 19. a 29.d 39. b
10. d 20. b 30. d 40. ¢
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Revision Questions Answers

An optical character reader is a device used to input normal, printed, or hand-written text. A Magnetic Ink
Character Reader is used to scan characters printed in magnetic ink. MICR is extensively used in banks.

Two types of Application Software are—packages and utilities.

Example of Packages—Microsoft Word

Example of Utility—Antivirus Software Quick Heal

Microcomputers are used in offices, schools, and homes.

Low level languages are machine dependent, so codes written for one machine might not work on the other.

High level languages use English and mathematical symbols and they make computer programming simpler.
High-level language programs are machine independent. They can run on different types of computers
without change.

A driver is a computer program that enables a computer to interact with a hardware device such as printer.
Feb, Mar, Apr, May
The two ways of creating a Custom List are Import and Add.

Select the list in Custom Lists box. The list appears in List entries box. Click Delete button. A confirmation
box appears. Click OK.

The Flash Fill feature recognises the data fill pattern in a worksheet and fills the remaining series accordingly.
For example, consider the worksheet

A B C D
1| Last Name | First Name | Middle Name Full Name
2 |Chaudhary |Sabeen C
3 |Tariq Azam A
4 |Dua Noshad
5 |Jamil Sumayyah

Enter Monica C Chowdhary in cell D2. In cell D3, start typing the first Name Siddhant. As you do, the Flash
Fill logic suggests a series of values to fill in cells D3:D5

A B C D
1] Last Name First Name | Middle Name Full Name
2 [Chaudhary |Sabeen C Sabeen C. Chudhary
3 |Tariq Azam A Azam A Tariq
4 |Dua Noshad Noshad Dua
5 [Jamil Sumayyah Sumayyah Jamil

Press Enter to accept the suggestions.

A B C D
1 Last Name First Name Middle Name Full Name
2 |Chaudhary Sabeen C Sabeen C. Chudhary
3 |Tariq Azam A Azam A Tariq
4 |Dua Noshad Noshad Dua
5 |Jamil Sumayyah Sumayyah Jamil

To delete the conditional formatting applied to a worksheet, click Clear Rules in the Conditional Formatting
drop down menu. A submenu appears. Click Clear Rules from Entire Sheet.

To add a customised guide, click either the horizontal or the vertical ruler. Drag the mouse to your publication
and release to add the guide at the desired location.

. To connect the text box:

a. Select the left text box. Click the FORMAT tab under TEXT BOX TOOLS and in the Linking group
click Create Link.
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b. The cursor changes to the link (a pitcher) icon. Click in the text box that you want to link, usually it is
the text box on the right.

The text boxes will be linked. Resize the linked box as necessary. Any text that overflows from the original
text box will now appear in the connected box.

The steps to add a picture in the picture placeholder are:
a. Click to display the boundary of the picture placeholder and the picture placeholder icon.
b. Click the placeholder icon to display the Insert Pictures dialog box.

c. Click the Office.com Clip Art option to place the insertion point in the respective search box. Type the
search term in the search box and press ENTER. A list of pictures appears.

d. Click the picture you want to insert and click the Insert button. The picture gets inserted in the publication.
The steps to add a caption to a picture are:

a. Select the picture.

b. Click the FORMAT tab under PICTURE TOOLS.

c. Click the Caption button in the Picture Styles group. The Caption gallery appears.

d. Select your preferred choice. To edit the caption text, just select it and type the new text.
The two input methods in Small Basic are:

a. ReadNumber( ): It allows reading numeric ( integer and floating) inputs.

b. Read(): It allows reading string input.

The rules for naming variables are:

a. They can only be made up of letters, numbers, and the underscore character.

b. The first character must be a letter.

c. They cannot be a reserved word of Small Basic.

Excel comes with pre-designed cell styles rather than formatting cells manually. It is a quick way to include
professional formatting for different parts of a workbook such as title, headers, and more. To apply a cell
style,

a. Select cell(s) where you want to apply formatting.

b. Click the Cell Styles command in the Styles group on the Home tab and select the desired style form the
drop down menu. A live preview of a format displays as you move the pointer. The selected cell style
will appear.

A reserved word has a special meaning to the compiler and cannot be used as a variable name.

A comment statement is used to provide explanation about the code. This helps the programmer to understand
and modify the code later on if required. It is non-executable and ignored by the compiler. An apostrophe is
used as the comment symbol. Anything written after the comment symbol will be ignored by the compiler.
For example,

‘This is a comment statement.

Concatenation means to add two string values one after another. For example,
A = “Hello!”

B = “How are you ?”

C=A+B

TextWindow.Write (C)

The output will be: Hello! How are you?
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The hierarchy of operators for evaluating an arithmetic expression is:

Parenthesis
Multiplication and division
Addition and Subtraction

The WriteLine( ) method after printing moves the pointer to the next line and the Write() method after
printing makes the pointer stay on the same line.

3.1415

TextWindow.Write (“Enter your name”)

name = TextWindow.Read ()

TextWindow.WritelLine (“Hello!” + name)

F5

a.
b.

1
56

Email is far quicker than normal post. A message can reach any part of the world in a fraction of a second.

We need not be at our computer all the time to receive a message.
Example of Number addressing scheme - 192.12.145.72
Example of letter addressing system—google.pk

Cc stands for carbon copy. It allows you to send the same message to two or more people at one go. BCc
stands for Blind Carbon Copy. It allows you to send the same message to several people without letting
them know that others have also received the same mail.

The two options of the Magnifier Tool are—Zoom In and Zoom Out.

The Lasso Tool is used to select irregular areas in a drawing.

Timeline window is used to set the sequence of the movie.
The keyboard shortcut to display the grid in Flash is Ctrl + *

The steps to draw a star shape using Polystar tool are:

a.
b.

C.

Select the PolyStar Tool.

From the Property Inspector, select the stroke and fill attributes.

Click the Options button in the Property Inspector. The Tool Settings dialog box appears.
i. Select Star for Style.

ii. Specify number of sides.

iii. Enter a number between 0 and 1 for the Star point size.

iv. Click OK to close the dialog box.
d. Click on the stage and drag to draw the shape.

The steps to create a new gradient are:

a.
b.

C.

Select Colour option from Windows menu. The Colour panel appears.
Click the drop down arrow of the Type box and select a gradient style—Linear or Radial.
Click the colour marker you want to change. The colour palette appears.

Select a colour. You can also click and shift the colour marker left or right on the gradient bar to adjust
the gradient.

To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off the
bar.

You can continue creating the gradient effect by adding colour markers and assigning colours to them.
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36. The different modifiers of the Pencil Tool are—Straighten, Smooth and Ink.
37. A symbol is a graphic image, animation, or button that is stored along with a movie.
38. The steps to insert a keyframe are:
a. Inthe Timeline window, click on a rectangular placeholder where you want to insert a keyframe.
b. Select Insert » Timeline » Keyframe.
39. A black dot represents a keyframe.
40. The steps to convert an existing drawing into a symbol are:
a. Select the Arrow (Selection) Tool.
b. Draw a selection area around the object on the Stage to select it.
c. Select Modify » Convert to Symbol. The Convert to Symbol dialog box appears.

i. Type a Name for the symbol.
ii. Type of symbol can be a Movie clip, a Button, or a Graphic. Choose Graphic.
iii. Click OK. The symbol now gets added to the Library panel.
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WORKSHEETS

Worksheets have been provided for all the chapters of the course book.
Each worksheet is of 15 marks and is recommended as a formative assessment paper.

It is possible to use these worksheets as they are by photocopying them in magnified size (120% approx.)
and distributing to the students.

The questions in the worksheets may also be used as samples to create your own additional worksheets.

They are also available as printable documents online digital resources.
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Chapter 1 The Computer System

1. Complete the crossword based on the clues given:

ACROSS

2. These computers are big, powerful computers used for bulk data processing.

3. Itis a computer application consisting of one or more programs.

DOWN

1. Itrefers to the computer programs needed for running or operating a computer system.
4. Itis a program that translates high-level language program into machine code.

5. Itis used to read information stored on cards such as magnetic strip cards.

2. Unjumble the letters to form words using the hints given:

a.

OMPCLIER ....cooviiiiiiiiiiicicec s

Hint: It translates the high-level program into machine language program.
TPOLTER ..ot

Hint: It is a printing device used for creating high quality graphics.
PTOLPA ..ot

Hint: It is the portable version of the desktop PC.

PTINU VIDECE .....ccooiiiiiiiiiieisiceiecesce s

Hint: It is a device that accepts input from the user.
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€. USOREC GRPRAMO .....ccrimiiriieirinieieesieteitsreeeesaeeee e sseeenennes

Hint: It is the program written in high-level language.

Who Am I? (5)
a. Iam the physical component of the computer system. ........ccccccoevvvvviircnnniicne.
b. Iam the language that the computer understands and can execute directly without translation. ............
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Chapter 2 Fformatting Data in excel 2013

1. Unjumble the letters to form words using the hints given: (5)

a.

MTINGAENL .....cooviiiiiiec s

Hint: It is the position where data is placed within the boundary of a cell.

PRAW EXTT ..ooviiiiiccc e

Hint: The option by which the data is confined to the cell but is displayed in multiple lines.

C OTNF s
Hint: A set of letters of the alphabet and numbers written in a particular style.
d. NNIERTATIOO ..o
Hint: It is the relative physical position or direction of text.
e. INREDLUNE ......ccooiiiiiiiee e
Hint: It is a type of text formatting.
2. Who AmTI? (5)
a. Iam the keyboard shortcut for formatting text in Italics. .........cccoovvviirnninni
b. Iam the default vertical alignment for any text entered in the worksheet.
c. Iam the group on the HOME tab where the Cell Styles button can be found.
d. Iam the default fontin Excel 2013. .......c.ccooorriiinnnen.
e. Iam the combination of keys used to write data in multiple lines in the same cell.

3. Identify the components A to E in the following figure of the Font group on the

HOME tab. (5)
Calibri 11 v A ATe B
E .. oB [ U~ g~ &;-AO...,D
Eén
C A
Al e B e
G e D e
B,
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Chapter 3 Advanced Features of e4cel 2013

1. Unjumble the letters to form words using the hints given: (5)

a.

INTLUOKE ..ottt
Hint: It is the group on the DATA tab where the Subtotal button is found.
FAMORT TEINAPR .....cocooiiiiiiiiiiicccc e

Hint: The tool using which the conditional formatting can be copied to other cells.

€. SSTELY ot
Hint: It is the group on the HOME tab where the Conditional Formatting command is available.
d. TIETLRENG ....ocooiiiiiiiiiiiciicicccec s
Hint: It is the feature of Excel 2013 that enables the user to easily view the highest and lowest values
from a large set of data.
€. AELCRSELUR .....ccccooiiiiiiiiiiniiciicnccc s
Hint: It is the option in the Conditional Formatting drop down menu to clear conditional formatting.
2. Who AmI? (5)
a. Iam the small black square in the lower right corner of the active cell(s). ..........cccccovuenuv.e.
b. Tam the feature in Excel 2013 that recognises the data fill pattern in a worksheet and fills the remaining
series accordingly. ..........cccceveunnn.
c. Tam the group on the HOME tab where the Sort & Filter button can be found. .........................
d. Tam the feature of Excel 2013 using which one can rearrange the data in ascending or descending order.
e. I am an ordered list of frequently used text entries that the user can enter quickly through AutoFill.
3. Search for the following five terms related to Excel 2013 in the grid on the right: (5)
Words: SORTING; AUTO FILL; FILTER; FLASH FILL; CUSTOM LIST
RIE|[SIOIR|T|IT | N|IG|A|T|D
AIQIR|E|U|{W|K|O|S|H|D|K
C|lUIS|T|IO/M|L|T|S|T|H|A
TIRIA|N|S|T|T|E|O|P|U|U
C|lUIS|TIO/M|A|F|S|T|V|T
Z|X|B/AIW|IA|D|IT|A|V|]O|O
FILIA|{S|H|F|I|L|L|R|G]|F
G|SID|E|T|T|T|T|P|B|S]|I
FIB|FIR|IU|L|T|E|R|B|A|L
VIA|P|/LIN|IE|E|R|O|D|D|L
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Chapter 4 Introducing Publisher 2013

1. Search for five words related to Publisher in the grid below: (5)
L J S \ A S H T
I R L A I G N (@)
G U I A R I Y B
A L G S U N T J
T E M P L A T E
U R @) R E E R C
R S R M R T E T
E M A @) S A W S
2. Label the parts marked from A to E of the Publisher screen: (5)

B 3 B

3. Who Am1I? (5)

a. Iam the folder which shows the entire set of templates for birthday cards.

b. Iam a text- formatting style that enlarges the first letter of the selected text.

c. Iam the view in the Publisher interface which is used to manage files, e.g., opening, saving, closing files,
CC. teeeri e,

d. Iam the blue lines that mark the edges of the printable area on each page of the publication. .................
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Search for five words related to graphics in Publisher in the grid below: (5)
N|] |[W|Z |A|S |[R |T |E
A T |[I |O|N|O |Y
R |U|I [A|R |I |Y |B |I
O|L |G |[R |E |S |I |Z |E
P |O|U|(C|] IN|L |I |L
S |[R |O|R |E |E |[W]|C |C
T|S |R|[M|R|T |R |T |F
T |[H|U|M|B [N |A |I |L
G |K|S |[E|] |[X |P (P |D
Unjumble the letters to form words using the hints given: (5)
a. CSATHRC REAA ......cooiiiiiiiccccccccas
Hint: It is the grey area that is the temporary holding area in a publication
b. PCEALOLHERD ......ccccooiviiiiiiniiiniccec e
Hint: A picture frame that provides a specific shape and size to hold the selected picture.
€. WASP .o
Hint: Icon that appears after a placeholder has been replaced with a picture.
d. ILFL oo,
Hint: It is one of the options in the “Apply to Background” submenu that covers the entire page.
€. AGPEPTASR ....ccccoviiiiiiiiicicccs
Hint: A type of building block in Publisher.
Who Am I? (5)
a. Iam the tab that appears on the ribbon on inserting a shape in the publication. ..........cccccccoeiiinnnnnn.
b. Iam the feature that provides artistic effects to the picture by changing the picture shape, border, and
other effects. ..o,
c. Iam the group under the Insert tab that has options to insert pictures in a publication. ...........c.cccccceueeee
d. Iam the identification text that accompanies a graphic. ..o,

I am the building block that is used to add borders, frames, etc., in a publication.
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Chapter 6 Basics of MS Small Basic

1. Complete the crossword based on the clues given: (5)
ACROSS
2. The window present at the centre of the screen, where Small
Basic programs are written. 1
3. The data or value that cannot be changed in a program. 2
4. Itis an action that an object in Small Basic can perform.
DOWN
1. Asequence of instructions written to perform a particular task.
3. Astatement thatis used to provide explanation about the code. |3
2. Unjumble the letters to form words using the hints given:
(5) .
a. TECOJB ..ot
Hint: It is the fundamental building block of Small Basic.
b. OREPROTA .....ccoiiiiiiiiicccccc e
Hint: A symbol used to perform a certain task on variables.
€. PPORYERT ....cooviiiicicieieccctee e
Hint: An attribute of an object in Small Basic.
d. DORWYEK ..ot
Hint: A reserved word in Small Basic.
€. NOCCTANTAONIE .....cccooviiiiiiciecccc e
Hint: An operator used for joining one string to another.
3. Who AmTI? (5)

a. I am the data or value in a program which cannot be changed during program execution.

b. Tam the operator used to compare the values of two expressions. ..........cccocoeeveveriiririnicccnnns
c. Iam a combination of constants, variables, and operators. ...........ccccceeriiiiiiiiiiinnnnen.
d. Tassigna value toa variable. .........cccooovviiiinnn

I am also called a branching statement. ...........cccccoeviiiiiiinnnnn.
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Chapter 7 The Internet as a Post Office

1. Complete the crossword based on the clues given: (5)
5
2 3
4
1
ACROSS
1. Itis a collection of web pages with related information.

2. Itis the front page or index page of any website.
DOWN
3. Itis a computer peripheral that lets users connect their computer to other computers using wired or
wireless telephone connections in order to transmit and receive data.
The last three letters of the domain name for a military organisation.
5. Itis the process of exploring the Internet.
2. Unjumble the letters to form words using the hints given: (5)
a. EBW WSEORBR ......ccoiiiiiiiiiiiiicccieieiesceie e
Hint: It reads HTML documents, converts them to a form that users can read, and displays them on a
computer screen.
b. RRUOSECE ........cocooiiiiiiiiiiiiiceieecceese e
Hint: In the acronym URL, it is the expansion for “R”.
C. OBIXN oo
Hint: It is the email folder that stores the incoming email messages.
d. SHTRA ..o
Hint: It is the email folder that stores deleted messages.
€. CEVRIES ..o

Hint: In the acronym ISP, it is the expansion for “S”.
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3. Search for five commonly used Email commands in the grid below: (5)
R|IE|P|E|A|R|S|A|M|E
FIO|RIW/A|R|DIH|O|D
N|E|S|L|IT|E|E|I|]J|E
DIH|SIR|G|P/M|S|E|L
GIDIDIE|R|L|T|Z|P]|E
FIO|F|P|S|Y W|P|T|T
P/ R|II|N|T|E|E|R|O|E
B|S|T|Y|K|L|N|U|R|P
A|C|O/M|P|O|S|E|N|E
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Chapter 8 Introduction to Flash CS3

List three facts about the following: 6
a. Merge Drawing Mode
b. Object Drawing Mode

Unjumble the letters to form words using the hints given: (5)
a. ORARW OTOL .....cccoovviviiiiiiciiicccccene

Hint: It is also called the Selection Tool.
b. REPPORYT OTCPESNIR ......cccceereirrreininieiniereeneereeneereeneenene

Hint: It is the panel that displays the properties of the selected object.

Hint: It is a system of intersecting horizontal and vertical lines on the stage.
d. OSSAL LOTO .....covviiiicicicicieicncccciees

Hint: It is the tool that is used to select irregular areas in the drawing.
€. EMITENIL .....cccooovoiiiiicccccces

Hint: It is the panel in the Flash window that is used to set the sequence of the movie.

Who Am I? 4)
a. Iam the keyboard shortcut to show /hide rulers. .........cccccocooiiiiiiiiis
b. Tam the extension for a Flash File. .......cooouiiioooieimeeiieeeeeeeeeeeeeeeeeeeeean

c. Iam the keyboard shortcut to open the Document Properties dialog box.

d. I am the tool that is used for clicking and dragging while holding down the mouse
PULtON. ..o
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Chapter 9 Drawing Tools in Flash CS3

1. Search for the five drawing tools in the grid given below: (5)
RIR|{C|O|O|R|S|]J|L|K|E
E|IR|A|V|S|G|T|I|U M|N
N|E|S|A|T | N|E|IT | D|U|P
DIC|IS|L|IT|N|E|S|F|P]|E
G|S|ID|IE|R|T|T|Z|P|S|N
RIE|C|T|IAIN|G|L|E|R|C
VIAIPIL|T|E|E|R|O|]J|I
AIN|IE|R|A|S|E|R|N|X]|L

2. Who AmI? (5)

a. Iam the tool that is used to draw polygons or stars. .......cccccecevvvriiicccccnnnnnne.

b. Tam the tool that is used to fill enclosed areas with solid colours and gradients.

d. Iam the term for a colour created by mixing two or more colours. .......c.ccoceevvieericcurnnnnnn.

e. Iam the tool that is used to create square shapes. ..........cccevvvuriiiiiiinns

3. Figure Speak (5)

The shapes marked A to E in the figure given alongside were created using the Brush Tool and by applying
different Painting Modes in the Brush Mode Modifier. Identify the Painting Modes used in shapes A to E.

:
1
1
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Chapter 10: Creating Animations in Flash CS3

1. Complete the crossword based on the clues given: (5)
4
5
1 3
2
ACROSS
1. Itis the basic unit of any movie.
2. Itis ared rectangle with a vertical line which indicates the current frame on the Stage and the current
status of the movie.
3. Itis the term used for an occurrence of a symbol in a movie.
DOWN
4. Itis a graphic image, animation, or button that is stored along with a movie.
5. Itis a folder in Flash CS3 that stores symbols.
2. Who AmI? (5)
a. Iam a critical point in an animation, where an object appears or changes, or begins or ends an action
such as fading, moving, etc. ........c.cccccevveviviiniinnnnnn.
b. Iam the keyboard shortcut to open the Library panel. .........ccccccevvniinnnes
I am the term used for the number of frames per second that an animation will play.
d. Iam the process which makes a drawing change into another drawing.
e. Iam the menu in which the Play option is available. ...........ccccccocenrnnnn
3. Identify the components of the Timeline window marked from A to E in the figure given below. (5)

&
il

Bl »

1
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WORKSHEET ANSWERS

Chapter 1 The Computer System

1. Across: 2. Mainframes; 3. Package

Down: 1. Software; 4. Interpreter; 5. Card Reader

2. 1. COMPILER; 2. PLOTTER; 3. LAPTOP;
4. INPUT DEVICE; 5. SOURCE PROGRAM

3. 1. Hardware; 2. Machine language; 3. Driver;
4. Optical Mark Recognition; 5. Supercomputer

Chapter 2 Formatting Data in Excel 2013

1. a. ALIGNMENT b. WRAP TEXT c. FONT
d. ORIENTATION e. UNDERLINE

2. a. Ctrl+I b. Bottom c. Styles
d. Calibri e. Alt+ Enter

3. A. Fill Color B. Decrease Font Size C. Borders
D. Font Color E. Bold

Chapter 3 Advanced Features of Excel 2013
1. a. OUTLINE b. FORMAT PAINTER c. STYLES d. FILTERING e. CLEAR RULES

2. a. FillHandle b. FlashFill c. Editing  d. Sorting e. Custom List

3. ] R|{E|S|O|IR|T|I |N|[G|A|T|D
AIQIRIE|U|W|K|O|S|H|D|K
cC/IU|sS|T|IOML|I|S|T|H|A
T RIAIN|IS|T|T|E|O|P|U|U
C|IU|IS|TIOM|A|E|S|T|V|T
Z|X|B|AIWIA|D|IT|A|V|O|O
FILIA|S|H|F|I|L|L|R|G|F
G|S|D|E|T|T|T|T|P|B|S|I
FIB|F|IR|U|L|IT/E|R|B|A|L
VIA|P|LIN|E|E|R|O|D|D|L
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Chapter 4 Introducing Publisher 2013

1. |[L|]J WIA|S | H|T
I R|{LIW|T|G|N|O
GIUIT|A|R|T|Y|B
AIL|G|S|U|N|T]|]
TIE|M|{P|L|A|T]|E
U R|IOIR|E|E|R|C
R|S|IRIM|{R|T|E|T
EIM|AIO|S | A|W|S
2. A. Quick Access Toolbar B. Page Navigation Pane C. Ruler
D. Tabs E. Ribbon
3. a. AllBirthday b. Drop Cap c. Backstage view
d. Margin guides e. Objects

Chapter 5 Graphics in Publisher 2013

1. [ N|J|W|Z|A|S|R|T]|E
C|lA|[P|T|I|O|N|O|Y
RIU|[T|A[R|T|Y|B|I
O|L|G|R|E|S|I|Z]|E
P/O|U|C|J|N|L|TI|L
SIR|O|R|E|E|W|C|C
T|IS|RIM|R|T|R|T|F
T HIUM|B|N|A|TI|L
G|K|S|E|J|X|P|P|D

2. a. SCRATCH AREA b. PLACEHOLDER
d. FILL e. PAGEPARTS
3. a. Drawing Toolstab  b. Picture Style

e

Caption

Borders & Accents

C.

C.

SWAP

Ilustrations
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Chapter 6 Basics of Small Basic
Across: 2. Editor; 3. Constant; 4. Method

1.

Down: 1. Program; 3. Comment

a.

OBJECT b. OPERATOR c. PROPERTY
KEYWORD e. CONCATENATION

Constant b. Comparison operator c. Expression
Assignment statement e. Conditional statement.

Chapter 7 The Internet as a Post Office

1. Across: 1. Website; 2. Home Page

2.

Down: 3. Modem; 4. MIL; 5. Surfing
a. WEB BROWSER b. RESOURCE c. INBOX
d. TRASH e. SERVICE
R|E|P|E|A|R|S|A|M|E
FIO| R W|A|[R|D| H|O|D
N|E|S|L|IT|E|E|I]|]J|E
DIH|S|R|G|P|M|S|E|L
G|D/D|E|R|L|T|Z|P|E
FIO|F|P|S|Y| W|P|IT]|T
PIR|I|N|T|E|E|R|O|E
B|S|T|Y K|L|N|U|R|P
A|CIOIM|P|O|S|E|N|E

Chapter 8 Introduction to Flash CS3

1.

a.

Merge Drawing Mode:

i. This is the default drawing mode.
ii. In this mode, if two shapes are overlapped, they merge together.
iii. In this mode, the covered area of the lower object is erased.

Object Drawing Mode:
i. This model draws shapes as separate objects.

ii. The shapes can be moved apart without altering their appearance.
iii. When you select an object in this mode, it gets surrounded by a rectangular bounding box.
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2. a. ARROW TOOL b. PROPERTY INSPECTOR c. GRID
d. LASSO TOOL e. TIMELINE

3. a. Ctrl+Shift+Alt b. fla c. Ctrl+]
d. Hand Tool

Chapter 9 Drawing Tools in Flash CS3

. [ RIR|C|O|O|R|S|J|L|KJE
EIR|IA{V|S|G|T|T|U M|N
N|E|S|A|T | N|E|I |D|U|P
D|C|S|L|I |N|E|S|F|P]|E
G|S|ID|E|R|TI|T|Z|P|S|N
RIE|C|T|{A|IN|G|L|E|R|C
VIAIP|IL|T|E|E|R|O]|]J|I
AIN|IE|R|A|S|E|R|N|X|L

2. a. DPolystar b. Paint Bucket c. Ink Bottle

d. Gradient e. Rectangle
3. A. Paint Normal B. Paint Fills C. Paint Selection
D. Paint Inside E. Paint Behind

Chapter 10: Creating Animations in Flash CS3

1. Across: 1. Frame; 2. Playhead; 3. Instance
Down: 4. Symbol; 5. Library

2. a. Keyframe b. CTRL+L c. Frame Rate
d. Shape Tweening e. Control

3. A. Frames B. Keyframe C. Elapsed Time
D. Frame Rate E. Current Frame
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TEST PAPERS

Test papers have been provided for all the chapters of the course book.
Each test paper is of 25 marks and has both theory (20) and practical (5) components.

The test papers may be used for pen and paper assessment or the questions in them could be used to create
your own assessment papers.

They are also available as printable documents in online digital resources
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Chapter 1 The Computer System

1. Fill in the Blanks (5)
a. Atabletisatype of ..o computer.
b. is a famous e-book reader.
Co e are large computers of the size of refrigerators.
do A printer is used to produce printouts for blind people.
2. Write T for the true statement and F for the false one. (5)

a. An assembler is a high-level language.
b. Cheque information is read by an MICR reader.
¢. Minicomputers are portable mobile computers.
Application software has two categories- packages and utilities.

A program in a high-level language is called an assembly program.

3. Very Short Answer Questions (5)
a. Name two output devices other than printers.
b. What are the two different categories of application programs?
c.  What is the full form of OCR?
Give two examples of high-level languages.
What is a utility?

4. Short Answer Questions (10)
a. Explain the difference between a high-level language and an assembly language.
b. Give four examples of system software?
c. What is the job of a compiler?
d. Classify computers according to their size.
What is the use of a barcode reader? What does a barcode help to do?
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Chapter 2 Fformatting Data in excel 2013

Fill in the Blanks (5)
Ae e refers to the position in which data is placed, within the boundary of a cell.

b. Fonts can be selected from a Font group on the ......................... tab.

c. There are 72 points in an inch when we talk about ......................... .

d. You can mix your colours to get the desired colour on the ......................... tab.

e. Ctrl + B key is used to make any text ......................... .

Write T for the true statement and F for the false one. (5)
a. Ctrl +Iis used to make any text bold.

b. Horizontal alignment can be left, right, or centre.

c. Left, right, or centre are vertical alignments.

d. The Currency command is part of the Number group.

e

Excel 2013 has pre-designed cell styles.

Very Short Answer Questions @
a. Name the two different types of date formats.

b.  Which tab has the Cell Styles command?

c. Name the different types of vertical alignment.

What is the use of the Wrap Text command?

Short Answer Questions (6)
a. Whatis a font?
b. Explain the process of merging data in cells.

c. What is the difference between horizontal and vertical alignment?

Lab Exercise (5)
Observe the given information about the marks of a group of students in Class X
class X. Now do the following Name Marks
a. Replicate the data in a Marks.xlsx file. Aleena 425
b. The first cell “Class X" has to be constructed by merging cells. Bobby 310
c. Give the cell with the title a green background colour and yellow to Dayood 2ol
all the other cells. Faroqq 299
d. The text should have horizontally centred alignment. {E;?:illm ;Lig
Change the font to Verdana, size 12. Javeria 320
Hamid 300
Abid 409
Sara 416
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Chapter 3 Advanced Features of e4cel 2013

1. Fill in the Blanks

a.

b
C.
d.
e

You can change the order of data in excel by using the ..............c.......... option.

Selectively blocking data that you don’t want to see is known as ............c.c.c........ .

The small black square at the lower right-hand corner of a cell is known as a .........c.c.cceoeeuce. .

You can add your own list to ......ccccccvevveneee. lists in Excel 2013.

Conditional formatting command is available in the ......................... group on the HOME tab.

2. Write T for the true statement and F for the false one.

a.

b
C.
d.
e

You can change the order of data by using the filter option.

Sorting is possible only by arranging data in ascending order.

You can conditionally format cells and highlight them with a different colour.
You can sort data by cell colour.

You cannot filter data by cell colour.

3. Very Short Answer Questions

(5)

(5)

@

a. How will you create a series 1,3,5,7, 9,..., 22 in Excel?
b. Give an example of a list which is sorted by name.
c. Suppose in a given list in Excel containing name data, you have to display data in alphabetical order.
Which option of Excel will you use?
d. What are the three types of filters in Excel 2013?
4. Short Answer Questions (3x2=06)
a. Differentiate between sorting and filtering.
b. What is conditional formatting?
c. What is the difference between flash fill and auto fill?
5. Lab Exercise (5)
See the information below on the heights of a group of children.
a. Open a test.xlsx file and input the above data. Name Height (in cm)
b. Sort the data in the list above according to height from tallest to | Abid 130
shortest. Bobby 141
c. Filter the data showing children with “above average” height. Sohail 157
d. Data for all the children with height >= 150 cm should be shown in | Daud 160
red background. Give the steps. Essa 122
Javeria 115
Hareem 127
Isra 117
Jamshed 165
Kamal 168
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Chapter 4 Introducing Publisher 2013

Fill in the Blanks (5)
a. Microsoft Publisher is part of the ............cc.......... suite.

b. Template thumbnails are organised by ...........ccc........ type.

c. The grey area on both sides of the card layout is the ......................... area.

d. Inabirthday greeting ........ccccc.......... information stores your contact details.

€. e help you align text in Microsoft Publisher.

Write T for the true statement and F for the false one. (5)

a. Thered area on both sides of the card layout is the scratch area.

b. The Status bar is located at the bottom of the Publisher screen.

c. Publisher automatically hyphenates text when typed or pasted.

d. “Grow text box to fit” shrinks the text so that it appears within the text box without overflowing.
e

For changing the colouring of text boxes, you can use the Shape Fill option.

Very Short Answer Questions @
a. What is the default extension of a Publisher file?
b. How do you connect two text boxes in Publisher?
c. Explain what is meant by Drop Cap text formatting style.
Name the different types of guides.

Short Answer Questions (6)
a. Name four types of professional documents you can create using Microsoft Publisher.
b. What are ligatures?

c. What is the use of the page navigation pane?

Lab Exercise (5
a. Prepare a New Year greetings card with the text “Wish you a great year ahead!”
b. Choose green font.
c. Use Lucida Calligraphy 12 as font and font size.
d. Use Drop Cap feature for the text.
Save the file as New Year.pub.
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Chapter 5 Graphics in Microsoft Publisher 2013

1. Fill in the Blanks (5)
a. Options to insert pictures and various shapes are available in the ......................... group on the INSERT
tab.
b. Youcan.......en.ee. the picture in shape to remove its unwanted portions.
c. Picture.....ccooeeeee. group provides artistic effects to the picture by changing the picture shape, border,
and other effects.
do A is an explanatory or identification text or a title that accompanies a graphic.
The scratch area is the ..........cccccceuee. area that appears around the publication page.
2. Write T for the true statement and F for the false one. (5)

a. You can drag only one object to the scratch area.
b. A thumbnail is a reduced size of a large graphic image.
c. Itis not possible to work with shapes in Publisher.
d. Publisher only provides you with one type of building block-Page Parts.
The Wrap Text button in the Arrange group has options to wrap the text around the picture.

3. Very Short Answer Questions (2)
a. Name any two building blocks in Publisher.
b. In which group is the Caption option found?

4. Short Answer Questions (8)
a. What is the use of the scratch area?
b. How many building blocks does publisher support? Name them.
c. What is meant by cropping a picture? How can you crop a picture in Publisher?

d. What are the different sources of pictures in Publisher?

5. Lab Exercise 5)

a. Prepare a poster for World Cup Football FIFA 2018: “Welcome FIFA World Cup Russia 2018” in the text
box using an option from WordArt.

b. Insert a picture of the world cup after searching for it on the Internet

c.  Apply a rectangular picture style to the poster with a golden background and an orange border.
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Chapter 6 Basics of MS Small Basic

Fill in the Blanks (5)
a. Alinein a programiscalleda ........ccccee.. .

b. is the basic building block of Small Basic.

c. If you want to assign a different name to an existing file, use the ......................... button.

d. You can execute an MS Small Basic program by clicking the ......................... button.

€. e are data and values that cannot be changed in a program.

Write T for the true statement and F for the false one. (5)

a. There is only one type of constant.

b. An Integrated Development Environment (IDE) has all the tools required for programming.
c. The Editor is present at the top of the screen.

d. Small Basic ignores white spaces.
e

The first character of a variable can be numeric.

Very Short Answer Questions (2
a. Explain the feature called “intellisense”.

b. Name the different types of constants in Small Basic..

Short Answer Questions 8)
a. Whatis a program?

b. What is an object in Small Basic? Give an example.

c.  What are the different types of variables allowed in Small basic?

d.

What are the different types of statements in Small Basic? What are conditional statements also known
as?

Lab Exercise (5)

The length of a rectangular field is I metres and the width is w metres. 1 and w are inputs to the Small Basic
Program. Ten students walk around the field ten times. Write a program to calculate the total number of
kilometres travelled by all the students. (The distances walked by all the students have to be added).
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Chapter 7 The Internet as a Post Office

1. Fill in the Blanks

b.

C

d.

......................... lets you create a new email message.
Web page is a document written in ............cccceeeee. .
......................... is used to read HTML documents.

The front page of any website is called the .......................

......................... stores deleted messages.

2. Write T for the true statement and F for the false one.

a.

b
C.
d.
e

You can send an email to only one person at a time.

Modem is the short form for modulator-demodulator.

There is only one type of Internet addressing—Letter Addressing.

Sending emails is very costly.

Contacts stores email addresses of your friends and other persons you know.

3. Very Short Answer Questions

a.
b.

C.

Explain the attachment option in email.
What is a URL?

How can you search for information on the Internet?

4. Short Answer Questions

a.

o3

-~ 0 oa o

What is the World Wide Web?

What are the different types of Internet addressing?
Name four important folders in Gmail.

What is the difference between the terms Cc and Bcec?

What is the difference between Forward and Reply?

What is DNS name resolution in the context of letter addressing?
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Chapter 8 Introduction to Flash CS3

Fill in the Blanks (5)
a. Youcan create ........ccccoeennenee. using Flash software.

b. is the white area in the centre of the screen.

c. The ., tool is used to magnify or minimise a drawing.

d. Ctrl Nisused toopenthe ..o dialog box.

e. The . tool is used to select irregular areas in a drawing.

Write T for the true statement and F for the false one. (5)

a. Flash provides five drawing modes for drawing shapes.
b. Flash was first created by Macromedia.

c. Ctrl + “is the short cut key for displaying the grid.

d. Flash does not allow you to enlarge a drawing.
e

The Arrow Tool is also called the Selection Tool.

Very Short Answer Questions (2
a. Explain the use of the Arrow Tool in Flash.

b. What is the smallest size of a frame in Flash?

Short Answer Questions 8)
a. What is meant by Timeline in Flash?

b. What are the various things you can create using Flash?

c. Name the different areas of the Tools panel in Flash?
d

Differentiate between the Merge Drawing mode and the Object Drawing mode.

Lab Exercise (5)
a. Open a document in Flash.

b. Inserta triangle.

c. Place three circles intersecting the edges of the triangle.

d. Do this for object drawing mode and merge drawing mode.

e. Move the circles away and draw diagrams to show the the difference in the two modes.
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Chapter 9 Drawing Tools in Flash CS3

1. Fill in the Blanks.

a.

b
C.
d.
e

Squares are created using the ......................... tool.
The colour of the outline of any shape is determined by the ......................... colour.
The .o tool is used to draw polygons and stars.

The .o option is used to draw freehand lines with no modification.

The .o tool is used to change the colour, style, and thickness of an existing line.

2. Write T for the true statement and F for the false one.

a.

b
C.
d.
e

The Paint Bucket Tool is used to erase lines and fills.

You cannot reshape the shapes drawn using the Rectangle Primitive Tool.
The Oval Primitive Tool is used to draw polygons and stars.

It is not possible to draw rectangles with rounded corners.

The Line Tool can be used to draw straight lines.

3. Very Short Answer Questions

a.
b.

C.

d.

f.

While drawing a rectangle with rounded corners, what do you have to specify first?
What is the use of the Paint Bucket Tool?

(5)

(5)

(6)

What do you choose from the Tools panel while specifying a painting mode when you are drawing with

the Brush Tool?
Which tool do you use to fill enclosed areas with solid colours?
How do you specify the line thickness while using the Line Tool?

What attribute do you have to specify in Polystar Tool to specify the depth of a star?

4. Short Answer Questions

a.

b.

)

If you are drawing an oval shape, what are the properties that you should select and modify from the

Property Inspector panel?

Explain the process of creating a star using Flash.
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Chapter 10 Creating Animations in Flash CS3

Fill in the Blanks (5)
a. A is the basic unit of any movie.

b. A is a graphic image, animation, or button that is stored along with a movie.

C AN, is the occurrence of a symbol.

d. F6 is the shortcut key for inserting a ...........ccocevuenees .
e

In s animation, you only specify the first and the last frame.

Write T for the true statement and F for the false one. (5)
a. Inframe-by-frame animation, you have to specify only the first and the last frame.

b. Shape tweening does not work on symbols.

c. Library is a folder in Flash CS3 that stores symbols.

d. Playhead is the basic unit of a flash movie.
e

For motion tweening, drawings must be converted into symbols.

Very Short Answer Questions @
a. Where are the symbols stored in Flash CS3?

b. What is the use of the timeline?

c.  What are the different types of tweening animation?

What is the short cut key for inserting a frame?

Short Answer Questions (6)
a. What is the difference between a symbol and an instance?
b. What is the difference between a frame and a keyframe?

c. What is the difference between frame-by-frame animation and tweening animation?

Lab Exercise (5)

Create an animation where a triangle changes into a square, which again changes into a pentagon, which
finally becomes a circle.
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Test Paper Answers

Chapter 1 The Computer System
1. a. mobile b. Kindle c. Minicomputers d. Braille
2. a. F b. T c. F d T e. F
3. a. LCD displays and plotters are also output devices.
b. The two different categories of application programs are packages and utilities.
c. Optical Character Reader is the full form of OCR.
d. Basic and C++ are two examples of high-level languages.
e. A utility is a program designed to do maintenance work on a system or on system components.

4. a. Anassemblylanguage is a machine-dependent low-level language where each instruction to the computer
is written using a letter combination. High-level languages use English-like syntax in source programs
and are more understandable than assembly languages.

b. Operating systems, compilers, assemblers, and interpreters are types of system software.

c. A compileris aprogram that translates a high-level computer language program into a machine language
program.

d. On the basis of size, we can classify computers into five groups—mobile computers, microcomputers,
minicomputers, mainframes, and supercomputers.

e. Barcodereaders are used to scan the barcodes on the body of any product. This is an input to the computer.
The computer uses the barcode to identify the product.

Chapter 2 Formatting Data in Excel 2013
1. a. Alignment b. HOME c. Fontsize d. Custom e. bold
2. a. F b. T c. F d T e. T
3. a. Short Date and Long Date are the two different date formats available.
b. The Cell Styles command is present on the HOME tab.
c. Top, middle, and bottom are the different types of vertical alignment.

d. Wrap text helps the text to be placed in the same cell in multiple rows. It does not allow text to spill over
to other cells.

4. a. A fontis a set of letters of the alphabet and numbers written in a particular style.
b. Select cells to be merged, click on Format cell, go to the Alignment tab and click on merge cells.

c. Vertical alignment is top, middle, or bottom whereas horizontal alignment is right, left, or centre within
a cell.

5. a. Open and save an Excel 2013 file called Marks.xIsx
b. Take the two cells Al and B1 and merge it. Insert data “Class X” inside the merged cell.
c. Place data “Name” and “Marks” in cells Bl and B2.
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Insert marks data (names and marks) for each student starting from C1:C2, D1:D2, and so on according
to the table provided.

Select all the data, click the Borders drop down menu arrow and select All Borders in the menu.
Select A1:A2 (merged cells), click the Fill Color option and fill the merged area in orange.
Similarly, select all the cells in the table from B1:B2 downwards and fill it with yellow colour.
Select the area of the data (A3:B12) and choose Centre in the Alignment group.

Select the full table. Click the drop down menu arrow of the Font command in the Font group and select
Verdana in the list. Click the drop down menu arrow of the Font Size command in the Font group and
select 12 as the size.

Chapter 3 Advanced Features of Excel 2013

1.
2.
3.

®

sorting b. filtering c. fill handle d. Custom e. Styles
F b. F c T d T e. F

In order to create a series like 1, 4, 7, ..., 22, type 1 in a cell, then type 4 in the cell immediately below.
Select both the cells and drag the data by the fill handle to get the other numbers of the series.

A telephone directory is a list sorted by name.
You will use the sorting option on name data to display the data in alphabetical order by name.
You can filter data by a list value, by a format or by a criterion in Excel 2013.

Sorting rearranges data in a specified order, while filtering selectively blocks or hides data you don’t
want to see.

Setting cell formatting according to conditions specified by the user is called conditional formatting.

Autofill is a feature that lets you quickly fill a range of cells with a series of data without typing it. Flash
fill is a feature that recognises the data pattern in a series of cells and fills the data series in the column.

Open a test.xlsx file and input the data with relevant colour fills as shown in the table.

Click the DATA tab. In the Sort & Filter group, click the Sort Largest to Smallest button. The data will
first be sorted in the descending order of height.

Select the header Height (in cm). Click the Filter button to enable filter in the cell. Click the drop down
menu arrow, select Number Filters in the drop down menu. Choose option Above Average from sub-
menu.

Select A2 to B11. Click Conditional Formatting and in the drop down menu click New Rule. Under the
Select a Rule Type box, click Use a formula to determine which cells to format. Under “Format values
in which this formula is true” type =$B2 >= 150. Click Format... , click the Fill tab and choose red as the
background colour.

Chapter 4 Introducing Publisher 2013

1.
2.

a.

a.

Microsoft Office b. publication  c. scratch d. business e. Guides

F b. T c. F d. F e. T
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The default extension of a Publisher file is .pub.
Click the FORMAT tab under TEXT BOX TOOLS, and select Create Link option in the Linking group.

In Drop Cap Text formatting style, only the first letter of the text is enlarged and in some cases it is the
dropped below the first line.

There are two types of guides-margin guides and Customisable guides.
Publisher allows you to create professional documents such as brochures, labels, cards, and certificates.

Ligatures are connections between characters that seem to create a single character out of two or more
characters.

The page navigation pane allows you to view and work with all the pages in your publication. You can
view the page thumbnails and add, delete, rearrange, and duplicate pages in this pane.

Open a suitable “Holidays” template in Publisher 2013.

Go to the Backstage view and save the file as New Year.pub
On the HOME tab, in the Objects group select Draw Text Box.
Type the message “Wish you a great year ahead!”.

Click the FORMAT tab under TEXT BOX TOOLS, and in the Font group select font as Lucida Calligraphy,
Font Size as 48, and Font Colour as green.

e.

On the FORMAT tab under TEXT BOX TOOLS, and in the Typography group select Drop Cap to stylize
the greeting.

Chapter 5 Graphics in Publisher 2013

1.
2.
3.

a.

a.

[lustrations b. crop c. Styles d. caption e. grey

F b. T c. F d F e. T

Page Parts and Calendars are two of the building blocks available in Publisher.
The Caption option is found in the Picture Styles group.

Scratch area is the grey area that appears around the publication page. It can be used as a temporary
holding area. If you are not sure where you want to move an item, you can drag it to the scratch area.

Publisher provides four types of building blocks-Page Parts, Borders and Accents, Calendars, and
Advertisements.

Cropping a picture is used to remove the unwanted portions in a picture. For cropping a picture, select
the Format tab in the Picture Tools tab and click the drop arrow of the Crop button. You can choose
different crop options here.

There are three sources for pictures in Publisher. You can browse for picture files in your computer, search
for them in Office.com Clip Art or search on the web via Bing image search.

Open Publisher and create a blank document.
To create a text box:

On the HOME tab, select the Draw Text Box button in the Objects group.
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Click the FORMAT tab under DRAWING TOOLS and in the Shape Styles group, do the following;:
i. Click Shape Fill to colour the text box with golden colour.

ii. Click Shape Outline to colour the border of the text box with orange colour

To insert a picture of the World Cup in your publication:

i. Click the INSERT tab.

ii. Inthe Illustrations group, click the Online Pictures button. The Insert Pictures dialog box appears.
iii. In Bing Image text box, type World Cup Football and press ENTER.

iv. Select the required picture and click Insert. The picture gets inserted in the publication.

You can resize the picture and change its style.

To insert WordArt text in your publication:

i. Click the INSERT tab.

ii. In the Text group, click WordArt. The WordArt styles will appear.

iii. Select the required style. The Edit WordArt Text dialog box appears.

iv. Enter the text “Welcome to FIFA World Cup Russia 2018” in the publication and click OK.

v. Resize the text box.

vi. Save your publication as WorldCup.pub.

Chapter 6 Basics of MS Small Basic

1.
2.
3.

a.

a.

a.

a.

Statement b. Object c. SaveAs d. Run e. Constants
F b. T c. F d T e. F

As we type a line of code in MS Small Basic, a popup window appears which gives us suggestions on
choosing a command. This feature is called intellisense.

In Small Basic constants are of two kinds, numeric constants and string constants.

A program is a sequence of instructions written to perform a particular task. It instructs the computer
what to do and how to do it.

An object is the fundamental building block of Small Basic. For example, TextWindow is an object, which
is a window that displays the output of a program.

There are two types of variables allowed in Small Basic - numeric type and string type. In addition, the
numeric type variables can be sub-divided into integer type and floating type.

Small Basic has assignment, conditional, and looping statements. Conditional Statements are also called
branching statements.

The code will be as follows:

TextWindow.write (“Enter the length of the field in metres”)

1

TextWindow.ReadNumber ( )

TextWindow.write (“Enter the width of the field in metres”)
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TextWindow.ReadNumber ( )

(2(14+ w)*10*10) /10000 ‘ The total distance covered by 10 students who run across the

field 10 times in kilometres.

TextWindow.WriteLine (“The total distance travelled by the 10 students who ran across the
field 10 times is “ + D + “kilometres”)

Chapter 7 The Internet as a Post Office

1.
2.
3.

a.

a.

Compose b. HTML c. Web Browser d. Home e. Trash
F b. T c. F d. F e. T

Attachment option allows you to attach and send files, such as a Word, Excel, or JPEG file, along with
the email. This option appears when you are composing a message.

A URL or Uniform Resource Locator is a unique address for a website or a web page on the Internet.
You can search for information on the Internet by using search engines like Google or Yahoo.

The World Wide Web, or simply the Web, is the world-wide collection of publicly accessible Web pages
stored on computers connected to the Internet. It is easy to retrieve information from the Web, and this
has helped to popularise the Internet.

There are two types of Internet addressing—-Number Addressing and Letter Addressing.
Inbox, Draft, Sent Mail, and Contacts are four important folders in Gmail.

In Cc you send the same message to several people at the same time. In Bec you send the same message
to many people at the same time but without letting them know that others have also received the same
message.

In Reply you answer, i.e. send a mail back to the person who sent you a mail. In Forward you send a
mail sent by someone to someone else.

When you enter a letter address in a browser, the Internet sends the information to DNS servers that
translate the letter address to the corresponding IP address. This process is called DNS name resolution.

Chapter 8 Introduction to Flash CS3

1.
2.
3.

a.

o

pT P

o8

animations b. Stage c. Zoom d. New Document e. Lasso

F b. T c. T d. F e. T

The Arrow Tool, also called the Selection Tool, is used to select single or multiple objects on the stage.
The smallest size of a frame in flash is 1 x 1 pixel.

Timeline is the panel in a Flash window used to set the sequence of a movie.

Flash can be used for creating interactive Web pages that combine images, sounds, videos, and animations.
You can also use Flash to create drawings and animations.
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The Tools panel is divided into four areas
e Tools area

¢ View area

e Colours area

* Options area

Merge drawing mode erases the overlapped area of the underlying object and the two objects merge.
Object drawing mode considers overlaid objects as separate.

Open a new document in Flash.

Choose Merge Drawing mode.

Insert a triangle.

Place three circles at the three corners of the triangle, intersecting the triangle edges slightly.
Move the object away. You will see that the edges of the triangle are erased.

Repeat steps (a) to (d), but this time choose Object Drawing mode in step (b).

We see that the original triangle can be seen even when the circles are moved away.

Chapter 9 Drawing Tools in Flash CS3
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When you draw a rectangle with rounded corners, you first have to specify the radius for the corners
and then draw the shape.

The Paint Bucket Tool is used to fill enclosed areas with solid colours and gradients.

You choose a Brush Mode Modifier from the Tools panel while specifying a painting mode. You can
also select the desired brush shape and size.

You use the Paint Bucket Tool to fill enclosed areas with solid colours.

You use the Property Inspector’s Line thickness option to specify the line thickness before using the Line
Tool.

We have to specify the Star Point size attribute in order to set the depth of the star while drawing a star
using the Polygon Tool.

While using the Oval tool use the Property Inspector panel to set the properties—start angle, end angle,
and inner radius.

For drawing a star you have to select the Polystar Tool from the drop down menu of the Rectangle Tool.
In the Property Inspector select stroke and fill attributes. Click options button from Property Inspector
and see the Tool settings. Select Star for Style. Select number of sides. Specify the Star Point size which
sets the depth of the star which should be a value between 0 and 1.
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Chapter 10 Creating Animations in Flash CS3

1. a. frame b. symbol c. instance d. keyframe e. tweened
2. a. F b. T c T d. F e. T

3. a. Symbols are stored in the Library folder in Flash CS3.

b. The Timeline is the area where you work with frames to organise and control the content and animation
of your movie.

There are two types of tweening animation, motion tweening and shape tweening.
d. F5 key is the shortcut key for inserting a frame.

4. a. Asymbolisa graphicimage, animation, or button that is stored along with a movie. It can be inserted in
the movie as many times as you want, i.e. symbols are reusable graphics. An instance is an occurrence
of a symbol. Each time you insert a symbol in a movie, you create an instance of that symbol.

b. A frame is the basic unit of any movie. It contains the content of any movie. A keyframe is a critical point
in the animation when an object appears or changes.

c. In frame-by-frame animation you have to provide every frame, whereas in motion tweening you can
provide only the first and the last keyframes.

5. a. Use Shape tweening for this exercise.
b. Select the first frame and draw a triangle
c. Select frame 40 in the timeline window and insert a keyframe.
d. On frame 40 select the drawing object, delete it, and insert a square.

e. Similarly on frame 80, insert a pentagon and remove the square and finally on frame 120, insert a circle
and remove the triangle.

f. Click any frame between 1 and 40. In the Property inspector panel, select Shape from the Tween drop
down list.

g. Repeat step (f) on any frame between 40 and 80, and 80 and 120.
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